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AllplexTM 2019-nCoV Assay 

 CHAPTER 1: Intended Use 
 
The Allplex™ 2019-nCoV Assay is an in vitro diagnostic (IVD) real-time 
reverse transcriptase polymerase chain reaction (RT-PCR) test intended for 
the qualitative detection of SARS-CoV-2 viral nucleic acids in human 
nasopharyngeal swab, oropharyngeal swab, anterior nasal swab, mid-
turbinate nasal swab, nasopharyngeal wash/aspirate, nasal aspirate, 
bronchoalveolar lavage (BAL) and sputum specimens from individuals who 
are suspected of COVID-19 by their health care provider. Testing is limited 
to laboratories certified under the Clinical Laboratory Improvement 
Amendments of 1988 (CLIA), 42 U.S.C. §263a, that meet requirements to 
perform high complexity tests. 
 
Results are for the identification of SARS-CoV-2 RNA. The SARS-CoV-2 RNA 
is generally detectable in respiratory specimens during the acute phase of 
infection. Positive results are indicative of the presence of SARS-CoV-2 RNA; 
clinical correlation with patient history and other diagnostic information is 
necessary to determine patient infection status.  
Positive results do not rule out bacterial infection or co-infection with other 
viruses. The agent detected may not be the definite cause of disease. 
Laboratories within the United States and its territories are required to 
report all results to the appropriate public health authorities.  
 
Negative results do not preclude SARS-CoV-2 infection and should not be 
used as the sole basis for patient management decisions. Negative results 
must be combined with clinical observations, patient history, and 
epidemiological information.  
 
The Allplex™ 2019-nCoV Assay is intended for use by qualified, trained 
clinical laboratory personnel specifically instructed and trained in the 
techniques of real-time RT-PCR and in vitro diagnostic procedures. The 
Allplex™ 2019-nCoV Assay is only for use under the Food and Drug 
Administration’s Emergency Use Authorization (EUA). 
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 CHAPTER 2: Summary and Explanation of the 
Test 

 
The technology of the Allplex™ 2019-nCoV Assay is a real-time reverse 
transcription polymerase chain reaction (RT-PCR) test. The 2019-nCoV 
primer and probe set(s) is designed to detect viral RNA of SARS-CoV-2 in 
non-pooled human nasopharyngeal swab, oropharyngeal swab, anterior 
nasal swab, mid-turbinate nasal swab, nasopharyngeal wash/aspirate, 
nasal aspirate, bronchoalveolar lavage (BAL) and sputum specimens. 
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 CHAPTER 3: Principle of the Procedure 
  
Nucleic acids are isolated and purified from specimen using a manual or an 
automated nucleic acid extraction system. 10 μL of Internal Control (RP-V 
IC) must be added before the extraction. Follow detailed extraction 
procedures in manufacturer’s instructions. 8 μL of purified nucleic acid is 
reverse transcribed using 5X Real-time One-step Buffer/Real-time One-
step Enzyme into cDNA which is then subsequently amplified in a CFX96TM, 
CFX96TM Dx, CFX96 Touch™, CFX96 Opus 96 Dx, Applied BiosystemsTM 
7500, or Applied BiosystemsTM 7500 Fast Dx real-time PCR systems.  
During the process, the probe anneals to a specific target sequence located 
between the forward and reverse primers.  During the extension phase of 
the PCR cycle, the 5’ nuclease activity of Taq polymerase degrades the 
probe, causing the reporter dye to separate from the quencher dye, 
generating a fluorescent signal.  With each cycle, additional reporter dye 
molecules are cleaved from their respective probes, increasing the 
fluorescence intensity.  Fluorescence intensity is monitored at each PCR 
cycle by the CFX96TM, CFX96TM Dx, CFX96 Touch™, CFX96 Opus 96 Dx, 
Applied Biosystems™ 7500 or Applied Biosystems™ 7500 Fast Dx real-time 
PCR detection systems. The result of amplification is reported through 
‘Seegene viewer’ analysis. The ‘Seegene viewer’ shows whether the 
exported data is 2019-nCoV Detected, Presumptive positive, or Negative 
for easy retrieval of result by the user. 
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 CHAPTER 4: Assay Materials 
 
Materials provided 
 
The reagents contained in one Allplex™ 2019-nCoV Assay kit are sufficient 
for 100/124 reactions. 
 
Table 1. Allplex™ 2019-nCoV Assay Composition 

 
 
  

Contents 
Volume 

(RP10250X/ 
RP10252W) 

Description 

2019-nCoV MOM 
500 µL /  
620 µL 

MuDT* Oligo Mix (MOM): 
- Amplification and detection reagent 
*MuDT is the brand name of Seegene’s 

oligo mixture 
Real-time 

One-step Enzyme 200 µL Enzyme mix for one-step RT-PCR 

5X Real-time 
One-step Buffer 

500 µL 
Buffer for one-step RT-PCR 
- Buffer containing dNTPs 

2019-nCoV PC 80 µL Positive Control (PC) for PCR control: 
- Mixture of pathogen and IC clones 

RP-V IC 1,000 µL 
Exogenous Internal Control (IC) of  
AllplexTM 2019-nCoV Assay 

RNase-free Water 1,000 µL 

Ultrapure quality, PCR-grade RNase-free 
Water provided for: 
1. Negative Control (NC) for PCR control 
2. RT-PCR Mastermix (Refer to Table 6) 
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Materials required but not provided 
 

Additional materials and equipment required  

• Disposable powder free gloves (latex or nitrile)  
• Pipettes (adjustable) and sterile pipette tips  
• 1.5 mL microcentrifuge tubes 
• Clean bench 
• Ice  
• Desktop centrifuge  

(1.5 mL microcentrifuge and 96 well plate centrifuge) 
• Vortex mixer  
• Instruments and kits for nucleic acid extraction 

Manufacturer Instrument Extraction Kit Catalog No./Reaction 
No. 

Seegene Seegene STARlet  
(67930-03) 

STARMag 96 X 4 
Universal Cartridge Kit  

384 reactions 
(744300.4.UC384) 

STARMag 96 X 4 Viral 
DNA/RNA 200 C Kit 

384 reactions 
(EX00013C) 

Hamilton 
Microlab STARlet 

IVD  
(173000-075) 

STARMag 96 X 4 
Universal Cartridge Kit  

384 reactions 
(744300.4.UC384) 

STARMag 96 X 4 Viral 
DNA/RNA 200 C Kit 

384 reactions 
(EX00013C) 

Seegene Seegene NIMBUS  
(65415-03) 

STARMag 96 X 4 
Universal Cartridge Kit  

384 reactions 
(744300.4.UC384) 

STARMag 96 X 4 Viral 
DNA/RNA 200 C Kit 

384 reactions 
(EX00013C) 

Hamilton 
Microlab NIMBUS 

IVD  
(65415-02) 

STARMag 96 X 4 
Universal Cartridge Kit  

384 reactions 
(744300.4.UC384) 

STARMag 96 X 4 Viral 
DNA/RNA 200 C Kit 

384 reactions 
(EX00013C) 

LG Chem 
AdvanSure E3 

System  
(YETS0001EG) 

AdvanSure NA EX Kit 

96 reactions 
Reagent Plate 
(RPE0001K01) 

Proteinase K Tube 
(RPK0001K01) 

Strip (E3 System) 
(YSTP0500KG) 

GeneAll 
N/A 

(Manual) 

Ribospin vRD 
(Viral RNA/DNA 
Extraction Kit) 

50 extractions  
(302-150 SG1701) 

QIAGEN 
N/A 

(Manual) 
QIAamp® DSP Viral 

RNA Mini Kit 
50 extractions  

(61904) 

Roche 
Roche MagNA 

Pure 96  
(MP96) 

DNA and Viral NA 
Small Volume Kit 

576 extractions  
(06 543 588 001) 

ThermoFisher  
Scientific 

KingFisher Flex  
automated 
extraction 

MagMAX 
Viral/Pathogen  

Nucleic Acid Isolation 
Kit  

200 extractions 
(A42352) 

2,000 extractions 
(A48310) 
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NOTE:   
(1) All extraction options are commercially available. 
(2) The Seegene, Hamilton, LG Chem, and GeneAll extraction 

reagents/instrumentation can be purchased through Seegene 
Technologies (CA, US), support@seegenetech.com 

(3) The Seegene and Hamilton extraction reagents/instrumentation are 
validated with Seegene Launcher V6 software. 

• PCR Instrument & Consumables 
① Applied Biosystems™ 7500 (ThermoFisher Scientific), 

Applied Biosystems™ 7500 Fast Dx (ThermoFisher Scientific) 
Consumables (Cat. No.) 

For Applied Biosystems™ 7500; 
• MicroAmp™ Optical 96-Well Reaction Plate  

(Cat. No. N8010560, ThermoFisher Scientific)  
• MicroAmp™ Optical 96-Well Reaction Plate with Barcode  

(Cat. No. 4306737, ThermoFisher Scientific) 
For Applied Biosystems™ 7500 Fast Dx. 
• MicroAmp™ Fast 96-Well Reaction Plate (0.1mL)  

(Cat. No. 4346907, ThermoFisher Scientific) 
• MicroAmp™ Fast Optical 96-Well Reaction Plate with Barcode, 0.1 mL 

(Cat. No. 4346906, ThermoFisher Scientific) 
For both Applied Biosystems™ 7500/7500 Fast Dx; 
• Optical Adhesive Covers  

(Cat No. 4360954, ThermoFisher Scientific) 
Software 

Applied Biosystems™ 7500 Applied Biosystems™ 7500 Fast Dx 

SDS software v2.0.5 
SDS software v1.4.1 (Windows XP) 

/ 1.5.1 (Windows 7 64-bit) 

 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:support@seegenetech.com
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② CFX96 TM Real-time PCR Detection System-IVD (Bio-Rad),   
CFX96 TouchTM Real-Time PCR Detection System (Bio-Rad) 
CFX96TM Dx System (Bio-Rad), 
CFX96 TouchTM Real-Time PCR Detection System (Bio-Rad),     
CFX Opus 96 Dx Real-Time PCR Detection System (Bio-Rad) 

Consumables (Cat. No.) 

• Hard-Shell® 96-Well PCR Plates, low profile, thin wall, skirted, 
white/white (Cat. No. HSP9655, Bio-Rad) 

• Hard-Shell® 96-Well PCR Plates, low profile, thin wall, skirted, 
white/white, barcoded (Cat. No. HSP9955, Bio-Rad) 

• Optical Flat 8-Cap Strips (Cat. No. TCS0803, Bio-Rad) 
• Low Tube Strip, WHT (Cat. No. TLS0851, Bio-Rad) 
• Optically Clear Heat Seal (Cat. No. 1814030, Bio-Rad) 
• Permanent Clear Heat Seal (Cat. No. 1814035, Bio-Rad)*** 
• PX1 PCR plate sealer (auto-sealer, Cat. No. 181-4000, Bio-Rad)*** 
• MicroAmpTM Optical 8-Cap Strip  

(Cat. No. 4323032, ThermoFisher Scientific) 
• MicroAmpTM Optical 8-Tube Strip (0.2 mL)  

(Cat. No. 4316567, ThermoFisher Scientific) 
• EU 8-Single Attachable Indented Cap (Cat. No. B79501, BIOplastics) 
• EU 0.2 ml Thin-wall 8-Tube Strip (Cat. No. B77009, BIOplastics) 
• Mini-centrifuge (Cat. No. Mini-6K, Protagen) 
• PCR plate centrifuge (Cat. No. MPC-P25, Powerlab) 
• 0.1ml 96-Well PCR plate Half Skirt (Cat. YPP-0.1-HSW, YongYue) 
• Sealing film (Cat. YPF-QPC, YongYue) 

 
*** The Permanent Clear Heat Seal must be used with the PX1 PCR 
Plate Sealer when running the Allplex™ assay  

Software 

CFX ManagerTM Software V3.1 or CFX MaestroTM Software V1 
CFX ManagerTM Software V3.1 for use with CFX96-IVD and CFX96TM Dx, 
CFX MaestroTM Software V1 for use with CFX96 Touch, or CFX MaestroTM 

V2.0 Software for use with the CFX Opus 96 Dx 
 
NOTE: All consumables for CFX96™ Real-time PCR Detection System-IVD, 
CFX96™ Dx System, CFX96 Touch™ Real-Time PCR Detection System, 
and CFX Opus Dx Real-time PCR Detection System can be purchased 
through Seegene Technologies (California, US). 
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 CHAPTER 5: Warnings and Precautions 
 
The AllplexTM 2019-nCoV Assay should be performed by qualified, trained 
personnel. 
 
• For in vitro diagnostic use. 
• For use under Emergency Use Authorization (EUA) Only 
• For Prescription Use Only 
• This product has not been FDA cleared or approved but has been 

authorized for Emergency Use by FDA under an EUA for use by 
authorized laboratories. 

• This product  has been authorized only for the detection of nucleic acid 
from SARS-CoV-2, not for any other viruses or pathogens. 

• This emergency use of this product is only authorized for the duration 
of the declaration that circumstances exist justifying the authorization 
of emergency use of in vitro diagnostics for detection and/or diagnosis 
of COVID-19 under Section 564(b)(1) of the Federal Food, Drug, and 
Cosmetic Act, 21 U.S.C. § 360bbb-3(b)(1), unless the declaration is 
terminated or authorization is revoked sooner. 

• Reliability of the results depends on adequate specimen collection, 
storage, transport, and processing procedure.  

• This test has not been validated for any other types of specimens other 
than those indicated in the intended use.  

• If not tested immediately, store extracted RNA at ≤ -70℃ until use and 
keep on ice during testing. 

• Workflow in the laboratory should proceed in a unidirectional manner.  
• Wear disposable gloves and change them before entering different 

areas. Change gloves immediately if contaminated or treat them with 
DNA decontaminating reagent. 

• Supplies and equipment must be dedicated to working areas and should 
not be moved from one area to another. 

• Do not pipette by mouth. 
• Do not eat, drink, or smoke in laboratory work areas. Wear disposable 

powder-free gloves, laboratory coats and eye protections when handling 
specimens and reagents. Wash hands thoroughly after handling 
specimens and test reagents. 

• Avoid contamination of reagents when removing aliquots from reagent 
tubes. Use of sterilized aerosol resistant disposable pipette tips is 
recommended. 

• Do not pool reagents from different lots or from different tubes of the 
same lot. 

• Do not use the product after its expiry date. 
• Do not reuse any disposable items. 
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• Use screw-capped tubes and prevent any potential splashing or cross-
contamination of specimens during preparation. 

• Avoid possible contamination of reagents with extracted nucleic acids, 
PCR products, and positive control. To prevent contamination of 
reagents, use of filter-tips is recommended. 

• Use separated and segregated working areas for each test run.  
• To avoid contamination of working areas with amplified products, open 

PCR reaction tubes or strips only in designated working areas after 
amplification. 

• Store positive materials separated from the kit’s reagents. 
• Handle all specimens as if infectious. Laboratory safety procedures 

(refer to Biosafety in Microbiological and Biomedical Laboratories & CLSI 
Documents) must be taken when handling specimens. Thoroughly clean 
and disinfect all work surfaces with 0.5% sodium hypochlorite (in de-
ionized or distilled water). Product components (product residuals, 
packaging) can be considered as laboratory waste. Dispose of unused 
reagents and waste in accordance with applicable federal, state, and 
local regulations. 

• Manipulation of potentially infected specimens should be performed in a 
certified Class II BSC in a BSL-2 facility or higher. This includes 
aliquoting and/or diluting specimens and nucleic acid extraction 
procedures involving potentially infected specimens.  

• Use appropriate personal protective equipment including but not limited 
to disposable gloves, laboratory coat/gown, and eye protection when 
handling specimens, reagents, pipettes, and other equipment.  

• Keep extracted RNA on cold block or on ice during reaction set-up.  
• Keep PCR reagents on cold block or on ice during reaction set-up. 
• Expiry date is 8 months from the date of manufacture when product is 

stored at ≤ -20℃. Please refer to label for expiry date. 
• Seegene STARlet and Seegene NIMBUS are private label devices and 

are the same as the Microlab STARlet IVD and Microlab NIMBUS IVD.  
There is no change in the device other than labeling. All four devices 
can be used interchangeably and generate equivalent results. 
Instruments indicated share the same software application (“Seegene 
Launcher”) and extraction kit (“STARMag 96 X 4 Universal Cartridge Kit” 
and “STARMag 96 X 4 Viral DNA/RNA 200 C Kit”). 

• This Allplex™ 2019-nCoV Assay is a qualitative in vitro test for the single 
or multiple detection of 3 target genes (E gene, RdRP gene, and N gene) 

• The brand name of “CFX96™ Real-time PCR Detection System” is 
changed to “CFX96™ Dx system”. Since there are no hardware changes 
to the systems, it is expected that performance of the Allplex™ 2019-
nCoV Assay will be the same with both systems. 

• “CFX Manager™ Dx Software v3.1” is an upgrade version of “CFX 
Manager™ Software v1.6”. The upgraded software includes 
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enhancements to the “Run” menu. These enhancements do not impact 
the results of data analysis; therefore, results will be the same. 
 



  Allplex™ 2019-nCoV Assay 

 

 CHAPTER 6: Storage and Handling Conditions 
 
Reagent storage and handling 

• Expiration date is 8 months from the date of manufacture when 
product is stored at -20 °C or below. 

• Completely thaw all reagents on ice prior to use 
• Do not store reagents in a frost-free freezer. 
• Do not use kits or reagents beyond indicated expiry date. 
• Always check the expiry date on the reagent tubes prior to use. 

 
NOTE: The performance of kit components is unaffected for up to 7 cycles 
of freeze and thaw. If the reagents are used only intermittently, they 
should be stored in aliquots. 
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Specimen storage and transport 
 

• Specimen types: human nasopharyngeal swab, oropharyngeal swab, 
anterior nasal swab, mid-turbinate nasal swab, nasopharyngeal 
wash/aspirate, nasal aspirate, bronchoalveolar lavage (BAL) and 
sputum specimens   

 
NOTE: Sample collection devices are not provided with the assay.   All 
testing for COVID-19 should be conducted in consultation with a healthcare 
provider. Refer to CDC guidelines for sample collection (Nasopharyngeal 
swab (NP) /oropharyngeal swab (OP) / anterior nasal swab / mid-turbinate 
nasal swab and sputum) and storage at:  
https://www.cdc.gov/coronavirus/2019-ncov/lab/guidelines-clinical-
specimens.html 
 

Once the swabs have been collected in accordance with CDC guidelines, it 
is recommended to use Universal Transport Medium (UTM) for collection of 
nasopharyngeal, oropharyngeal anterior nasal and mid-turbinate nasal 
swabs.   

• After collection, the specimen should be stored at 2-8°C and processed 
within 72 hours. 

• If delivery and processing exceed 72 hours, specimens should be 
transported in dry ice and once in laboratory frozen at -70°C or colder.  
 

 

NOTE:  
(1) Performance may be affected by prolonged storage of specimens.  
(2) Specimens transport should adhere to local and national instructions  

for transport of pathogenic material. 
(3) Specimens should be collected and handled according to the swab 

collection device manufacturer’s recommended procedures. 

  

https://www.cdc.gov/coronavirus/2019-ncov/lab/guidelines-clinical-specimens.html
https://www.cdc.gov/coronavirus/2019-ncov/lab/guidelines-clinical-specimens.html
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 CHAPTER 7: Assay Control Material(s)  
 
PCR controls 
 

The PCR controls below are provided with the Allplex™ 2019-nCoV Assay 
to confirm the validity of each PCR run on the same plate. 

Prior to determining the validity of each PCR run, the user must confirm the 
results of the negative control and positive control on the ‘Well Plate’ on 
the upper left corner of the Seegene viewer. 

The results of the negative control and positive control are displayed under 
the ‘Auto Interpretation’ column on the bottom half of the Seegene viewer. 
If the positive and/or negative control results are invalid, the corresponding 
PCR run must be repeated.  

1. Negative Control (NC) is used as a PCR control to confirm test validity, 
and the absence of any contaminants during testing. The “No template” 
control is prepared using RNase-free Water added to the Master Mix prior 
to PCR. NC must be included in each test run. No signal should be 
detected with the NC. 

 
2. Positive Control (PC) is used to confirm test validity, and functions as 

the validation control for PCR amplification and the test detection steps. 
The PC is constructed using plasmids encoding Allplex™ 2019-nCoV 
Assay target sequences and must be included in each test run.  

 
NOTE: The Positive Control included in this kit is a high concentration PCR 
control. Dilute the PC with TE buffer by 1:10 before use. 
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The real-time PCR results of the positive and negative control can be viewed 
from the Seegene Viewer as shown in Picture 1 and Picture 2.  

 

Picture 1. Example of valid positive/negative control results 

 

Picture 2. Example of invalid positive/negative control results 

 

 
Table 2. Allplex™ 2019-nCoV Assay; Control Acceptance Criteria 

Control 
Seegene Viewer Result (Ct value) 

IC         
(HEX) 

E gene  
(FAM) 

RdRP gene 
(CalRed 610) 

N gene 
(Quasar 670) 

Auto 
Interpretation 

2019-nCoV 
Positive 
Control 

≤ 40 ≤ 40 ≤ 40 ≤ 40 Positive Control 
(+) 

>40 or N/A >40 or N/A >40 or N/A >40 or N/A Positive Control 
(Invalid) 

Negative 
Control 

>40 or N/A >40 or N/A >40 or N/A >40 or N/A 
Negative Control  

(-) 

≤ 40 ≤ 40 ≤ 40 ≤ 40 Negative Control 
(Invalid) 
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Internal Control 
 
The Allplex™ 2019-nCoV Assay includes a full process Internal Control (RP-
V IC) which is composed of MS2 phage genome. This Internal Control 
material verifies all steps of the analysis process, including sample 
extraction, reverse transcription, and PCR to demonstrate proper specimen 
processing and test validity of each specimen.  

 
A positive signal for the Internal Control indicates that all processing steps 
performed by the Allplex™ 2019-nCoV Assay were successful. 

A negative signal of all targets including the Internal Control invalidates 
all negative results in the analysis. Repeat testing if an invalid result is 
reported. Refer to section ‘Interpretation of Results’ for more details. 

 
 
External Control 

External controls are not provided with the Allplex™ 2019-nCoV Assay. 
Quality control requirements should be performed in conformance with local, 
state, and/or federal regulations or accreditation requirements and your 
laboratory’s standard quality control procedures. 
 
The following external controls are available: 
AccuPlexTM SARS-COV-2 reference material (Seracare Life Sciences, Inc., 
Cat no. 0505-0126; this kit includes positive & negative reference material.) 
The positive reference material may be used as an external extraction 
control. 
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 CHAPTER 8: Procedure 
 
Sample collection, transport, and storage 
 
Collect Nasopharyngeal swab (NP) /oropharyngeal swab (OP)/nasal 
swab/mid-turbinate nasal swab, nasopharyngeal wash/aspirate, nasal 
aspirate, bronchoalveolar lavage (BAL) and sputum according to CDC 
guidelines and/or manufacturer’s protocol for sample collection, storage 
and handling.   
 
Nucleic acid extraction 
 
The assay was validated with the extraction options listed below. Perform 
the RNA extraction on samples according to the manufacturer’s instructions 
for use. For the Microlab STARlet IVD, Seegene STARlet, Microlab NIMBUS 
IVD and Seegene NIMBUS extraction methods, follow the detailed 
instructions provided in the section of ‘Preparation on Microlab STARlet IVD, 
Seegene STARlet, Microlab NIMBUS IVD and Seegene NIMBUS’. 
 
Seegene STARlet / Seegene NIMBUS / Microlab STARlet IVD / Microlab NIMBUS IVD 
(STARMag 96 X 4 Universal Cartridge Kit; Cat No. 744300.4.UC384) 
See Operation Manual of each instrument or the section under 'preparation' for details. 
- Sample volume: 300 μL, Elution volume: 100 μL 

Seegene STARlet / Seegene NIMBUS / Microlab STARlet IVD / Microlab NIMBUS IVD 
(STARMag 96 X 4 Viral DNA/RNA 200 C Kit; Cat No.EX00013C) 
See Operation Manual of each instrument or the section under 'preparation' for details. 
- Sample volume: 300 μL, Elution volume: 100 μL 
AdvanSure E3 System  
(AdvanSure NA EX Kit; Cat No.RPE0001K01,RPK0001K01) 
See AdvanSure NA EX Kit User Manual for details. 
- Sample volume: 200 µL, Elution volume: 100 µL 
QIAamp® DSP Virus Spin Kit  
(Cat No.61704) (QIAGEN) 
Follow the ‘Protocol Purification of viral nucleic acids from plasma or serum’ of the QIAamp® 
DSP Virus Spin Kit Handbook. 
- Specimen volume: 190 μL, Elution volume: 40 μL 
Ribospin™ vRD  
(Viral RNA/DNA Extraction Kit (Cat No.302-150, SG1701) (GeneAll) 
See Ribospin™ vRD Manual for details. 
- Specimen volume: 290 µL, Elution volume: 40 µL 
KingFisher™ Flex automated extraction  
(MagMAX Viral/Pathogen Nucleic Acid Isolation Kit, Cat No. A42352) 
See MagMAX Viral/Pathogen Nucleic Acid Isolation Kit Manual for details. 
- Specimen volume: 200 μL, Elution volume: 50 μL 
Roche MagNA Pure 96 (MP96)  
(DNA and Viral NA Small Volume Kit; Cat No.06 543 588 001) 
See DNA and Viral NA Small Volume Kit Manual for details. 
- Specimen volume: 200 μL, Elution volume: 50 μL 
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Preparation on Microlab STARlet IVD, Seegene STARlet, Microlab NIMBUS 
IVD and Seegene NIMBUS: 

Hardware installation, Seegene Launcher software for operation and 
customer training (on-site and/or video tutorial) are provided by Seegene 
Technologies (California, US), support@seegenetech.com. 
The Seegene Launcher is an application software that controls functions 
and protocols of the Microlab STARlet IVD/Seegene STARlet/Microlab 
NIMBUS IVD/Seegene NIMBUS. 
The user manual of ‘Seegene Launcher V6’ containing detailed descriptions 
of instrument maintenance and experimental procedures of nucleic acid 
extraction using Microlab STARlet IVD, Seegene STARlet, Microlab NIMBUS 
IVD and Seegene NIMBUS will be provided. 

The purification procedure is designed to ensure safe and reproducible 
handling of potentially infectious samples and comprises of 4 steps: sample 
lysis, nucleic acids binding to magnetic beads, debris washing and elution 
of purified nucleic acids.  

The  instructions below describe the procedures for operating the Microlab 
STARlet IVD and Seegene STARlet. For Microlab NIMBUS IVD and Seegene 
NIMBUS, the same Seegene Launcher software is used. Please follow 
exactly the same procedure as below after selecting NIMBUS in the setting 
during installation of the launcher.  

 
For STARMag 96 X 4 Universal Cartridge Kit: 
 
1. Take out 1 cartridge from the STARMag 96 X 4 Universal Cartridge Kit.  

1 cartridge contains reagents for 96 tests, and the STARMag 96 X 4 
Universal Cartridge Kit contains 4 cartridges (384 tests).  

Picture 3. 1 cartridge from the STARMag 96 X 4 Universal Cartridge Kit 

Table 3. Components of STARMag 96 X 4 Universal Cartridge Kit 

Reagents Volume 
Lysis Buffer Universal LB 4 X 23 mL 

mailto:support@seegenetech.com
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Reagents Volume 
Binding Buffer Universal BB 4 X 68 mL 

Wash Buffer 1 Universal WB1 4 X 55 mL 
Wash Buffer 2 Universal WB2 4 X 10 mL 
Wash Buffer 3 Universal WB3 4 X 55 mL 
Elution Buffer Universal EB 4 X 18 mL 
Universal Magnetic Beads 4 X 1.8 mL 
Lysis Buffer Universal LB 200 mL 

Universal Proteinase K (lyophilized)  4 X 75 mg 
Proteinase Buffer Universal PB 4 X 3 mL 

Tub Cover 25 ea. 
User Manual 2 ea. 

 
NOTE:  

(1) Lysis Buffer (LB), Binding Buffer (BB), and Wash Buffer 1 (WB1) 
contain chaotropic salt. Wear gloves and goggles always when 
handling buffers. 

(2) Store all the components of extraction reagent kit at room 
temperature (18 – 25 °C). In case of dissolved Proteinase K, store at 
-20 °C. 

(3) The expiration date of the product is indicated on the label. The 
cartridge remains effective for up to 15 months prior to its opening 
and for up to 4 months after its opening. 

(4) All buffers are delivered ready-to-use. 
(5) Lysis Buffer (LB) may form a salt precipitate during storage. To re-

dissolve the precipitate, incubate the buffer bottle at 40 °C until the 
precipitate is re-dissolved completely. 
 

2. Before placing the cartridge on the Microlab STARlet IVD, Seegene 
STARlet, Microlab NIMBUS IVD or Seegene NIMBUS, prepare the 
following: 
 
• Proteinase K: When using the kit for the first time, add 2.6 mL 

Proteinase Buffer Universal PB to the lyophilized Proteinase K. 
Dissolved Proteinase K solution is stable at – 20 °C for at least 6 
months. Transfer the Proteinase K solution into a 1.5 mL microtube 
according to the number of samples. The volume of Proteinase K 
solution is automatically calculated by the Launcher software if the 
number of samples is entered into the software. 

• Wash Buffer 2 Universal WB2: Prepare 48 mL of absolute ethanol (Cat. 
No. 1.00983.1011, Merck). After removing the film from the WB2 tub, 
add 48 mL of absolute ethanol into the WB2 tub. The WB2 tub should 
be covered after use and should be stored at room temperature (18 
– 25 °C). 
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• Magnetic Bead: Suspend the magnetic beads by manually tapping the 
tube  followed by a quick vortex. 

 

For STARMag 96 X 4 viral DNA/RNA 200 C Kit; 

 
1. Take out 1 cartridge from the STARMag 96 X 4 viral DNA/RNA 200 C Kit. 

1 cartridge contains reagents for 96 tests, and the STARMag 96 X 4 viral 
DNA/RNA 200 C Kit contains 4 cartridges (384 tests).  

 

Picture 4. 1 cartridge from the STARMag 96 X 4 viral DNA/RNA 200 C Kit 

 

Table 4. Components of STARMag 96 X 4 viral DNA/RNA 200 C Kit 

Reagents Volume 

Lysis Buffer LB 4 X 23 mL 
Binding Buffer BB 4 X 68 mL 

Wash Buffer 1 WB1 4 X 55 mL 
Wash Buffer 2 WB2 4 X 10 mL 
Wash Buffer 3 WB3 4 X 55 mL 
Elution Buffer EB 4 X 18 mL 
Magnetic Beads 8 mL 

Bead Tube (2 mL tube) 4 ea. 
Tub Cover 25 ea. 

User Manual 1 ea. 
 

NOTE:  

(1) Store all the components of the extraction reagent kit at room 
temperature (18 – 25 °C). 

(2) The expiration date of STARMag 96 X 4 Viral DNA/RNA 200 C Kit is 
indicated on the box label and store up to 1 month after its opening. 
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(3) All buffers are delivered ready-to-use. 
2. Before placing the cartridge on the Microlab STARlet IVD or Seegene 

STARlet, prepare the following: 
 

 Add 48 mL of absolute ethanol into WB2 tub before use. WB2 tub should 
be covered with Tub Cover after using and stored at room temperature 
(18 - 25 °C). 

 After sufficiently vortexing the Magnetic beads in the bottle, transfer 1.8 
ml of Magnetic beads to bead tube (2 mL tube) before use.  

  

Table 5. Materials required, but not provided  

Basic Item 

Absolute EtOH 

Disposable powder free gloves (latex or nitrile) 

Desktop centrifuge 

Ice or cooler box 

Pipettes (adjustable) and sterile aerosol resistant pipette tips 

Vortex mixer 
 

Purchasing Item Cat. No. Manufacturer 

SMP-CAR-24-Tube Carrier Set-4  
(24 sample carrier) 

173440 Hamilton 

SMP CAR 12 D35 (12 sample carrier) 185052 Hamilton 

1.5 mL sterile microtubes MCT-150-C Axygen 

96 Deep Well Micro Plate SDP0096 Supercon 

Deep well plate, 96 wells with Barcode label SDP0096B Supercon 

MicroAmp®  Optical 8-Tube Strip (0.2 mL) 4316567 Applied Biosystems 

EU 0.2 ml Thin-wall 8-Tube Strip B77009 BIOplastics 

Hard-Shell® PCR plates 96-well WHT/WHT HSP9655 Bio-Rad 
Hard-Shell® PCR plates 96-well WHT/WHT, 

b d d 
HSP9955 Bio-Rad 

0.1ml 96-Well PCR plate Half Skirt YPP-0.1-
 

YongYue 

Low Tube Strip, WHT TLS0851 Bio-Rad 

MicroAmp® Optical 8-Cap Strip 4323032 Applied Biosystems 

EU 8-Single Attachable Indented Cap B79501 BIOplastics 

Optical Flat 8-Cap Strips TCS0803 Bio-Rad 

Sealing film YPF-QPC YongYue 

Optically Clear Heat Seal 1814030 Bio-Rad 

Permanent Clear Heat Seal 1814035 Bio-Rad 

PX1 PCR plate sealer (auto-sealer) 1814000 Bio-Rad 
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Mini-centrifuge Mini-6K Protagen 

PCR plate centrifuge MPC-P25 Powerlab 

UPS HP 910 Sampoongpower 
 

NOTE: All purchasing items listed above can be purchased through 
Seegene Technologies (California, US). 
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Operation 

NOTE:  
(1) Prior to running the Seegene launcher, inspect the deck and carriers for 

cleanliness and empty the tip waste/liquid waste if there are any. 
(2) A minimum of 300 μL specimen volume is required to ensure 200 μL of 

specimen pipetting by Microlab STARlet/Seegene STARlet. This will 
result in 100 μL elution volume of nucleic acids (RNA) necessary to run 
the Allplex™ 2019-nCoV Assay. 

(3) Only 12mm tubes, 16mm tubes and 1.5 mL micro centrifuge tubes can 
be directly loaded to the Microlab STARlet/Seegene STARlet.  

(4) For information on maintenance, refer to the Seegene Launcher V6 
manual. 
 

1. Open the Seegene launcher software installed on the laptop connected 
to the Microlab STARlet IVD/Seegene STARlet for operation of the 
Microlab STARlet IVD/Seegene STARlet.  

 
2. Click on LAUNCHER RUN on the main page. 
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3. Select 2019-nCoV (protocol for Allplex™ 2019-nCoV Assay) to begin 
the protocol. All following steps are included in a step by step 
instruction included in the software. 

 
4. Check and follow the instructions carefully and then click on Work List. 

Samples, Internal Control, consumables, and 1 cartridge from the 
STARMag 96 X 4 Universal Cartridge Kit are placed on the Microlab 
STARlet IVD/Seegene STARlet while following step by step instructions 
guided by the Seegene Launcher software. 
 
NOTE: After equilibrating specimens to room temperature, vortex each 
specimen briefly.  
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5. A barcode reader installed inside the Microlab STARlet IVD/Seegene 
STARlet automatically reads sample information. The sample 
information can also be manually entered, if necessary.  
Click on Next, once Sample Quantity, Barcode, Name (optional) and 
labware (1.5 ml,12 mm or 16 mm) information are entered correctly. 
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6. Using a hand-held barcode reader provided with the Microlab STARlet 
IVD/Seegene STARlet, read barcode label attached on the side of the 
cartridge. After the Extraction Reagent Barcode information is entered, 
click on Next. If the remaining volume of the existing cartridge is 
insufficient to run the desired number of samples, a second cartridge 
needs to be barcoded and placed. 

 

 
 
 
7. Ensure that the Microlab STARlet IVD/Seegene STARlet door is firmly 

closed, and that the eject plate and labware are in their correct positions 
as shown below. Click on Run after all preparations are done. 
Do not open the door of the Microlab STARlet IVD/Seegene STARlet 
during operation. 
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8. Check that the reagents are in the right position and click on OK to 
start the run. 
 

For STARMag 96 X 4 Universal Cartridge Kit; 

 

 

For STARMag 96 X 4 viral DNA/RNA 200 C Kit;  
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For further inquiries regarding the extraction procedure, contact Seegene 
Technologies (California, US) at support@seegenetech.com.  

Please refer to the user manual of ‘Seegene Launcher V6’ for detailed 
descriptions of experimental procedures of nucleic acid extraction using 
Microlab STARlet IVD and Seegene STARlet. 

 
  

mailto:support@seegenetech.com
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Amplification and detection: Bio-Rad CFX Systems 
 

A video tutorial is available upon request to Seegene Technologies       
(California, US, support@seegenetech.com) for training on all experimental 
procedures related to amplification and detection under this section. 
Seegene Viewer v 3.20 or higher for auto-interpretation of results is 
provided by Seegene Technologies (California, US), 
support@seegenetech.com. 

 

Preparation for real-time PCR 

NOTE:  

(1) To prevent contamination, prepare reagents in a PCR workstation or 
equivalent amplicon-free area. Do not use the same pipette for 
controls and samples, and always use aerosol barrier pipette tips. 

(2) Extracted RNA handling and PCR reagent preparation must be 
performed at different areas. 

(3) Remove all reagents from ≤ -20℃ storage. After thawing them 
completely, spin down each reagent for quick spin.  

(4) The provided positive control (PC, PCR control) and clinical sample RNA 
extracts require special caution in handling to avoid carry-over 
contamination. 

(5) Include one Positive Control and one Negative Control on each plate.  
 

 
1.  Prepare the following reagents in a labeled sterile 1.5 mL tube. Set up 

all reagents on ice. 
 

Table 6. One-step RT-PCR Mastermix for different number of reactions 
(unit: μL) 

 
2. Mix by inverting each reagent tube 5 times or quick vortex, and briefly 

centrifuge. 
 
In 96-well PCR plate, Aliquot 17 μL of the One-step RT-PCR Mastermix 
into PCR tubes. NOTE: Prior to adding specimen extract/positive controls 

No. of Reactions  1 2 3 4 5 

2019-nCoV MOM 5 10 15 20 25 
RNase-free Water 5 10 15 20 25 

5X Real-time One-step Buffer 5 10 15 20 25 
Real-time One-step Enzyme 2 4 6 8 10 

mailto:support@seegenetech.com
mailto:support@seegenetech.com
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to PCR plate, move from the reagent prep area to a specimen processing 
area. 
 

3. Add 8 μL of each sample’s extracted nucleic acids, 2019-nCoV PC and 
NC (RNase-free Water; Negative Control (NC) for PCR control) into the 
tubes containing aliquot of the One-step RT-PCR Mastermix. 
 

4. Cover with Permanent Clear Heat seal for 96-Well Skirted PCR Plates on 
PX1™ PCR Plate sealer, and briefly centrifuge the PCR tubes. 

 
NOTE: The PCR tubes must be centrifuged before running the PCR 
reaction in order to force the liquid to the bottom and eliminate air 
bubbles. 

 

5. Verify that the liquid containing all PCR components is at the bottom of 
each PCR tube. If not, centrifuge again at a higher RPM and for a longer 
time. 
 

6. Immediately initiate the PCR on the Bio-Rad CFX96 instruments. See 
details on PCR instrumentation set-up below. 
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Real-time PCR Instrument Set Up 

 

Protocol Setup 

1. In the main menu, select File  New  Protocol to open Protocol Editor.   
 

 
 

2. In Protocol Editor, define the thermal profile as table below. 

Step No. of cycles Temperature Duration 

1 1 50℃ 20 min 

2 1 95℃ 15 min 

3 
45 

94℃ 15 sec 

4 58℃ 30 sec 

5 GOTO Step  3, 44 more times 
 

NOTE: Plate Read at Step 4. Fluorescence is detected at 58°C. 
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3. Click the box next to Sample Volume to directly input 25 μL.  
 

 
 

4. Click OK and save the protocol to open the Experiment Setup window. 
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Plate Setup 

1. From Plate tab in Experiment Setup, click Create New to open Plate Editor 
window. 

 

2. Click Select Fluorophores to indicate the fluorophores (FAM, HEX, Cal 
Red 610 and Quasar 670) that will be used and click OK. 
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3. Select the desired well(s) and then its sample type from the Sample Type 
drop-down menu. 

• Unknown: Clinical samples 
• Negative Control 
• Positive Control 

 

 

 

4. Click on the appropriate checkboxes (FAM, HEX, Cal Red 610 and Quasar 
670) to specify the fluorophores to be detected in the selected wells. 
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5. Type in Sample Name and press enter key. 

 

 

6. In Settings of the Plate Editor main menu, choose Plate Size (96 wells) 
and Plate Type (BR White). 

 

7. Click OK to save the new plate. 

 

8. You will be returned to the Experiment Setup window. 
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Real-time PCR run 

 

Start Run 

 
1. From Start Run tab in Experiment Setup, click Close Lid to close the 
instrument lid. 

  
2. Click Start Run.  

 

3. Store the run file either in My Documents or in a designated folder. Enter 
the file name, click SAVE, and the run will start. 
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Data export and analysis 
 

Data export 
(CFX96 Touch™, CFX Manager™ Software V3.1 & CFX Maestro™ 
Software) 
(CFX96™ and CFX96™ Dx, CFX Manager™ Dx Software V3.1) 
(CFX96 Touch™, CFX Maestro™ Software V1) 
(CFX Opus 96 Dx, CFX Maestro™ Software V2.0) 
 
1. Create folders for data export 

• Create a folder to save amplification curve detection results. 

• The location and name of the folder are specified by user, but in 
case of using ‘Seegene Export’ function, the folder named 
“QuantStep4” is created automatically in the selected location. 
 

2. After the PCR reaction, select No Baseline Subtraction from Baseline 
Setting of Settings menu. 

 
 

3. Select Excel 2007 from Export All Data Sheets from Export menu. 
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4. Choose a location to save data and click OK. 
 
Data analysis 
 
1. Open the Seegene Viewer software installed on the laptop connected to 

the Bio-Rad CFX96™. 

 
2. Click on the Open icon and find CFX96™ export data on the location 

where CFX96™ data was saved. 
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3. After opening the results file, select ‘Allplex™ 2019-nCoV Assay (FDA 
EUA only)’ from the PRODUCT menu. 

 
4. View test results. The results for each sample can be viewed by clicking 

on each well.  
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Table 7. Analytes of the Allplex™ 2019-nCoV Assay 

 

 

 

 

 

 

 

  

Fluorophore Analyte 

FAM E gene 

HEX Internal Control (IC) 

Cal Red 610 RdRP gene 

Quasar 670 N gene 
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Amplification and detection: Applied Biosystems™ 7500 
 

Preparation for real-time PCR 

NOTE:  

(1) To prevent contamination, prepare reagents in a PCR workstation or 
equivalent amplicon-free area. Do not use the same pipette for 
controls and samples, and always use aerosol barrier pipette tips. 

(2) Extracted RNA handling and PCR reagent preparation must be 
performed at different areas. 

(3) Remove all reagents from ≤ -20℃ storage. After thawing them 
completely, spin down each reagent for quick spin.  

(4) The provided positive control (PC, PCR control) and clinical sample RNA 
extracts require special caution in handling to avoid carry-over 
contamination. 

(5) Include one Positive Control and one Negative Control on each plate.  
 

 
1.  Prepare the following reagents in a labeled sterile 1.5 mL tube. Set up 

all reagents on ice. 
 

Table 6. One-step RT-PCR Mastermix for different number of reactions 
(unit: μL) 

 
2. Mix by inverting each reagent tube 5 times or quick vortex, and briefly 

centrifuge. In 96-well PCR plate, Aliquot 17 μL of the One-step RT-PCR 
Mastermix into PCR tubes.  
 
NOTE: Prior to adding specimen extract/positive controls to the PCR plate, 
move from the reagent prep area to a specimen processing area. 
 

3. Add 8 μL of each sample’s extracted nucleic acids, 2019-nCoV PC and NC 
(RNase-free Water; Negative Control (NC) for PCR control) into the tubes 
containing aliquot of the One-step RT-PCR Mastermix. 
 

4. Cover with adhesive covers for 96-Well PCR Plates, and briefly centrifuge 
the PCR tubes. 

No. of Reactions  1 2 3 4 5 

2019-nCoV MOM 5 10 15 20 25 
RNase-free Water 5 10 15 20 25 

5X Real-time One-step Buffer 5 10 15 20 25 
Real-time One-step Enzyme 2 4 6 8 10 
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5. Verify that the liquid containing all PCR components is at the bottom of 
each PCR tube. If not, centrifuge again at a higher rpm and for a longer 
time. 
 

6. Immediately initiate the PCR on the Applied Biosystems™. See details on 
PCR instrumentation set-up below. 
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Real-time PCR Instrument set up 

NOTE: The instrument must be calibrated before use. 

1. In the Applied Biosystems™ 7500 software, click on Setup → Advanced 

set up. 

 

 

2. In the Experiment properties tab, enter Experiment Name and select 
Instrument, Experiment type, Reagents, and Ramp speed as follows. 

Instrument 7500 (96 Wells) 

Experiment type Quantitation – Standard Curve 

Reagents Taqman® Reagents 

Ramp speed Standard 
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3. Click on Plate setup tab. In the Define Targets and Samples tab, enter 

Target Name and select Reporter and Quencher as follows. 

Target Name Reporter Quencher 
E FAM None 
IC VIC None 

RdRP ROX None 
N CY5 None 
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4. Click on Assign Targets and Samples tab, select wells where the PCR 
tube will be placed and assign targets. Select None for Passive reference. 

NOTE: If a well without sample or Mastermix is selected, signal noise may 
be observed. Ensure that only wells containing samples or Mastermix are 
selected. 

  

 

5. Click on Run Method. In the Graphical View or Tabular View tab, enter 
25 µL as the Reaction Volume per Well field. Define the thermal profile as 
table below. 

 

 

 

 

 

NOTE: Plate Read at Step 4. Fluorescence is detected at 58°C. 

  

Step No. of cycles Temperature Duration 

1 
1 

50 °C 20 min 

2 95 °C 15 min 

3 
45 

94 °C 15 sec 

4 58 °C 30 sec 

5 GOTO Step 3, 44 more times 
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6. Click on File → Save as Template to save the new template file in .edt 

format. Enter the file name, select a location for the template, then click 
Save. The saved template can be used for future testing. 
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Start the Run 
1. Turn on the laptop and Applied Biosystems™ 7500 real-time PCR 
system. Ensure that the laptop is connected to the instrument. 

2. Push the tray door to open the instrument. Load the PCR plate onto the 
plate holder of the instrument. 

3. Push the tray door to close the instrument.  

4. Click on File → Save As to save experiments in .eds format. 

  

5. Click START RUN. 
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Data export and analysis 

Create folders for data export 

1. Create a folder to save data for all of the amplification curve detection 
steps from the result file.  

2. Enter folder name as necessary. 

 

Data export 

1. Click on File → Export 

 

2. Click on the Export Properties tab (default) and select Sample Setup, 
Raw data, Amplification Data, Results, and Multicomponent Data under 
1. Select data to export. 

 

3. Select ‘One File’ under 2. Select one or separate files:  

4. Enter Export File Name, then select Export File Location.  

5. Select .xls in the File Type drop-down list. 

6. Click Start Export.  
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Data analysis 

 
1. Open the Seegene Viewer software installed on the laptop connected to 
the Applied Biosystems™ 7500. 

 
2. Click on Option to select AB7500 v2.0.5 from the Instrument menu.  

 

3. Click on the Open icon and locate the Applied Biosystems™ 7500 
export data where the Applied Biosystems™ 7500 data was saved. 
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4. After opening the results file, select ‘Allplex™ 2019-nCoV Assay (FDA 
EUA only)’ from the PRODUCT menu.  

 
5. Assign Positive and Negative control accordingly by selecting PC and 

NC under the Type drop-down menu.  
 

 
 

6. View test results. The auto-interpreted results for each sample can be 
viewed by clicking on each well.  
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Amplification and detection: Applied Biosystems™ 7500 Fast 
Dx 
 

Preparation for real-time PCR 

NOTE:  

(1) To prevent contamination, prepare reagents in a PCR workstation or 
equivalent amplicon-free area. Do not use the same pipette for 
controls and samples, and always use aerosol barrier pipette tips. 

(2) Extracted RNA handling and PCR reagent preparation must be 
performed at different areas. 

(3) Remove all reagents from ≤ -20℃ storage. After thawing them 
completely, spin down each reagent for quick spin.  

(4) The provided positive control (PC, PCR control) and clinical sample RNA 
extracts require special caution in handling to avoid carry-over 
contamination. 

(5) Include one Positive Control and one Negative Control on each plate.  
 

 
1.  Prepare the following reagents in a labeled sterile 1.5 mL tube. Set up 

all reagents on ice. 
 

Table 6. One-step RT-PCR Mastermix for different number of reactions 
(unit: μL) 

2. Mix by inverting each reagent tube 5 times or quick vortex, and briefly 
centrifuge. 
 
In 96-well PCR plate, Aliquot 17 μL of the One-step RT-PCR Mastermix 
into PCR tubes. NOTE: Prior to adding specimen extract/positive controls 
to the PCR plate, move from the reagent prep area to a specimen 
processing area. 
 

3. Add 8 μL of each sample’s extracted nucleic acids, 2019-nCoV PC and NC 
(RNase-free Water; Negative Control (NC) for PCR control) into the tubes 
containing aliquot of the One-step RT-PCR Mastermix. 
 

4. Cover with adhesive covers for 96-Well PCR plates, and briefly centrifuge 
the PCR tubes. 

No. of Reactions 1 2 3 4 5 

2019-nCoV MOM 5 10 15 20 25 
RNase-free Water 5 10 15 20 25 

5X Real-time One-step Buffer 5 10 15 20 25 
Real-time One-step Enzyme 2 4 6 8 10 
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5. Verify that the liquid containing all PCR components is at the bottom of 

each PCR tube. If not, centrifuge again at a higher rpm and for a longer 
time. 
 

6. Immediately initiate the PCR on the Applied Biosystems™ 7500. See 
details on PCR instrumentation set-up below. 
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Real-time PCR Instrument set up 
NOTE: The instrument must be calibrated before use. 

1. In the SDS software, click on Quick Startup → Create New Document. 

 

 

2. In New Document Wizard, select Assay, Container, Template, and Run 
mode as below then enter Plate Name.  

Assay Standard Curve (Absolute Quantitation) 

Container 96-Well Clear 

Template Blank Document 

Run mode Standard 7500 
 

 

 
3. In Select Detectors, click on New Detector to add reporter and 

quencher information of analytes. 
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4. In New Detector, enter Detector Name, Description (optional) and 
select Reporter, Quencher as table below.  

Detector Name Reporter Quencher 
E FAM None 
IC VIC None 

RdRP ROX None 
N CY5 None 
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5. In Select Detectors, add E, IC, RdRP, and N to Detectors in Document 
field by clicking on Add >>. Select none for Passive Reference. 

 

6. In Set Up Sample Plate, drag and select the wells where the PCR tube 
will be placed and assign targets by clicking on the check boxes next to 
each Detector and select Unknown from Task. 

NOTE: If a well without sample or Mastermix is selected, signal noise may 
be observed. Ensure that only wells containing samples or Mastermix are 
selected. 

 

7. In the Setup – Plate tab, confirm the run plate information.  
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8. In the Instrument tab – Thermal Cycler Protocol, define the thermal 
profile as below. Enter 25 µL in the Sample Volume (μL) field, select 

Stage 3, Step 2 [58.0°C @ 0:30] for Data Collection (Plate Read)  

 

 

 

 

 

NOTE: Plate Read at Step 4. Fluorescence is detected at 58°C. 

 

9. Click on File → Save As to save the new template file in .sdt format. 

Enter File name, select a location for the template, then click on Save. 
The saved template can be used for future testing. 

Step No. of cycles Temperature Duration 

1 
1 

50°C 20 min 

2 95°C 15 min 

3 
45 

94°C 15 sec 

4 58°C 30 sec 

5 GOTO Step 3, 44 more times 
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10. To open the saved run protocol file, click on Browse in the Template 

field to open the template file. 
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Start the Run 

1. Turn on the laptop and Applied Biosystems™ 7500 Fast Dx real-time 
PCR system. Ensure that the laptop is connected to the instrument. 

2. Push the tray door to open the instrument. Load the PCR plate onto the 
plate holder of the instrument. 

3. Push the tray door to close the instrument.  

4. Click on File → Save As to save the experiment in .sds format. 

   

5. Click on Start.  
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Data export and analysis 

Create folders for data export 

1. Create a folder to save data for all of the amplification curve detection 
steps from the result file.  

2. Enter folder name as necessary. 

 

Data export 

1. Click on File → Export → Results and select the data file to export. 

 

2. Select the location to save exported files and enter ‘_Result’ at the end 
of the file name. Then click on Save. 
 
e.g. 200420-Allplex 2019-nCoV Assay_AB FAST_Result 
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3. In Export Settings, click on OK without checking the boxes. 
 

 
 
4. After exporting the Ct file, export data containing graphs by clicking on 
File → Export → Component. 

 
 
5. Select the location to save exported files, and enter ‘_Result-g’ at the 
end of the file name. Then click on Save. 
 
e.g. 200420-Allplex 2019-nCoV Assay_AB FAST_Result-g 
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Data analysis 

 
1. Open the Seegene Viewer software installed on the laptop connected to 
the Applied Biosystems™ 7500 Fast Dx  

2. Click on Option to select AB7500 FastDx from the Instrument menu.  

 

3. Click on the Open icon and locate the Applied Biosystems™ 7500 Fast 
Dx export data where the Applied Biosystems™ 7500 data was saved. 
The name of the file should end in ‘_Result’ 
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4. After opening the results file, select ‘Allplex™ 2019-nCoV Assay (FDA 
EUA only)’ from the PRODUCT menu. 

 
5. Assign Positive and Negative Control accordingly by selecting PC and 

NC under the Type drop-down menu. 

 
6. View test results. The auto-interpreted results for each sample can be 

viewed by clicking on each well.  
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 CHAPTER 9: Interpretation of Results 
 

All PCR controls should be examined prior to interpretation of patient 
results. If the controls are invalid, the patient results cannot be interpreted 
and reported. 

One Negative Control and one Positive Control are processed with each run. 

The results are analyzed by the Seegene Viewer software. Assessment of 
clinical specimen test results should be performed after the positive and 
negative controls have been examined and determined to be valid and 
acceptable. The results are validated using the Seegene Viewer auto-
interpretive software based on performance of the Positive Control and 
Negative Control. In cases of validity failure, the sample results should not 
be interpreted or reported, and the run must be repeated. 

The Seegene Viewer software is installed on a separate computer that is 
interfaced with the Bio-Rad CFX96™ or Thermofisher Scientific Applied 
Biosystems™ 7500/7500 Fast Dx. The results are exported and transferred 
to the Seegene Viewer according to instructions under the section of 
‘Procedure: application and detection’ provided for each instrument.  

The auto-interpreted results can be exported to obtain a report in a 
preferred format (such as excel or pdf). 

Seegene Viewer software (V 3.20 or higher) is provided by Seegene 
Technologies (California, US), support@seegenetech.com. 

 

Result interpretation for clinical specimens is presented in Table 8.  

mailto:support@seegenetech.com
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 Table 8. Result interpretation, clinical specimens 

Ct value Result 

≤ 40 Detected (+) 

> 40 or N/A Not detected (-) 

 

Potential 

Result 

Type 

IC 

(HEX) 

E gene 

(FAM) 

RdRP 

gene 

(CalRed 

610) 

N gene 

(Quasar 

670) 

Auto-

Interpretation 
Interpretation/Further Actions 

Case 1 +/- + + + 
2019-nCoV 

Positive 

All Target Results are valid. 

2019-nCoV (SARS-CoV-2) RNA is Detected. 

Case 2 +/- + - + 

2019-nCoV 

Positive 

All Target Results are valid. 

2019-nCoV (SARS-CoV-2) RNA is Detected. 

Missing amplification of individual targets  may 

be due to: 

1) a sample at concentrations near or below the 

limit of detection of the test, 

2) a mutation in the corresponding target region, 

or 

3) other factors. 

Case 3 +/- + + - 

Case 4 +/- - + + 

Case 5 +/- - - + 

Case 6 +/- - + - 

Case 7 +/- + - - 

Presumptive 

positive for 

2019-nCoV 

All Target Results are valid. 

Sarbecovirus RNA is detected but 2019-nCoV 

(SARS-CoV-2) specific RNA targets are not 

detected. 

Repeat testing. For samples with the same result 

on a repeated test, additional confirmatory 

testing may be conducted, if it is necessary to 

differentiate between 2019-nCoV (SARS-CoV-2) 

and SARS-CoV-1 or other Sarbecovirus currently 

unknown to infect humans, for epidemiological 

purposes or clinical management. 

Missing amplification of the 2019-nCoV (SARS-

CoV-2) specific targets may be due to: 

1) a sample at concentrations near or below the 

limit of detection of the test, 

2) a mutation in the corresponding target region, 

or 

3) other factors. 

Case 8 + - - - Negative 
All Target Results are valid. 2019-nCoV (SARS-

CoV-2) RNA is Not Detected. 

Case 9 - - - - Invalid 
Results are invalid. Repeat test. If the result is 

still invalid, a new specimen should be obtained. 

 



 
 

Page 66 / 88 

AllplexTM 2019-nCoV Assay 

 CHAPTER 10: Assay Limitations  

 
• The use of this assay as an in vitro diagnostic under the FDA Emergency 

Use Authorization (EUA) is limited to laboratories that are certified under 
the Clinical Laboratory Improvement Amendments of 1988 (CLIA), 42 
U.S.C. § 263a, to perform high complexity tests.  

 
• Use of this assay is limited to personnel who are trained in the procedure. 

Failure to follow these instructions may result in erroneous results. 
 
• The performance of the Allplex™ 2019-nCoVAssay was established using 

nasopharyngeal swab, oropharyngeal swab and sputum samples. 
Anterior nasal swabs and mid-turbinate nasal swabs are also considered 
acceptable specimen types for use with the Allplex™ 2019-nCoV Assay 
but performance has not been established. Testing of nasal and mid-
turbinate nasal swabs (self-collected or collected by a healthcare 
provider) is limited to patients with symptoms of COVID-19. Please refer 
to FDA’s FAQs on Diagnostic Testing for SARS-CoV-2 for additional 
information.  
https://www.fda.gov/medical-devices/emergency-situations-medical-
devices/faqs-diagnostic-testing-sars-cov-2  

 
• SARS-CoV-2 may mutate in one or more of the target regions of the 

Allplex™ 2019-nCoV Assay. If this occurs, then SARS-CoV-2 may not be 
detected.  

 
• Based on the in silico analysis, SARS-CoV and other SARS-like 

coronaviruses in the same subgenus (Sarbecovirus) as SARS-CoV-2 may 
cross-react with the Allplex™ 2019-nCoV Assay. SARS-CoV is not known 
to be currently circulating in the human population, therefore is highly 
unlikely to be present in patient specimens.  

 
• Samples must be collected, transported, and stored using appropriate 

procedures and conditions. 
 
• False negative results may arise from improper specimen collection, 

handling, and degradation of the viral RNA during shipping/storage.  
 
• Detection of viral RNA may not indicate the presence of the infectious 

virus or that 2019-nCoV is the causative agent for clinical symptoms.  
  

https://www.fda.gov/medical-devices/emergency-situations-medical-devices/faqs-diagnostic-testing-sars-cov-2
https://www.fda.gov/medical-devices/emergency-situations-medical-devices/faqs-diagnostic-testing-sars-cov-2
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• Extraction and amplification of nucleic acid from clinical samples must be 
performed according to the specified methods listed in this procedure. 
Other extraction approaches and processing systems have not been 
evaluated.  

 
• Avoid contamination by adhering to good laboratory practices and to the 

procedures specified in this package insert.  
 
• False positive results may happen from cross- contamination between 

patient samples, specimen mix-up and RNA contamination during 
product handling.  

 
• False-negative results may arise from:  

o Improper sample collection  
o Degradation of the viral RNA during shipping/storage 
o Specimen collection after nucleic acid can no longer be found 

 in the specimen matrix  
o The presence of RT-PCR inhibitors  
o Mutation in the SARS-CoV-2 virus  
o Failure to follow instructions for use 

 
• Negative results do not preclude infection with SARS-CoV-2 virus and 

should not be the sole basis of a patient management decision.  
 

A positive result indicates the detection of nucleic acid from the 
relevant virus. Nucleic acid may persist even after the virus is no 
longer viable. 

 
• The performance of this test was established based on the evaluation of 

a limited number of clinical specimens. Clinical performance has not been 
established with all circulating variants but is anticipated to be reflective 
of the prevalent variants in circulation at the time and location of the 
clinical evaluation. Performance at the time of testing may vary 
depending on the variants circulating, including newly emerging strains 
of SARS-CoV-2 and their prevalence, which change over time. 
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 CHAPTER 11: Conditions of Authorization for 
Laboratory 
 

The AllplexTM 2019-nCoV Assay Letter of Authorization, along with the 
authorized Fact Sheet for Healthcare Providers, the authorized Fact Sheet 
for Patients, and authorized labeling are available on the FDA website: 
https://www.fda.gov/medical-devices/coronavirus-disease-2019-covid-
19-emergency-use-authorizations-medical-devices/in-vitro-diagnostics-
euas-molecular-diagnostic-tests-sars-cov-2. However, to assist clinical 
laboratories using the AllplexTM 2019-nCoV Assay, the relevant Conditions 
of Authorization are listed below.  

1. Authorized laboratories1 using the AllplexTM 2019-nCoV Assay must 
include with result reports of the AllplexTM 2019-nCoV Assay, all 
authorized Fact Sheets. Under exigent circumstances, other appropriate 
methods for disseminating these Fact Sheets may be used, which may 
include mass media.  

2. Authorized laboratories using the AllplexTM 2019-nCoV Assay must 
perform the AllplexTM 2019-nCoV Assay as outlined in the AllplexTM 
2019-nCoV Assay Instructions for Use. Deviations from the authorized 
procedures, including the authorized instruments, authorized extraction 
methods, authorized clinical specimen types, authorized control 
materials, authorized other ancillary reagents and authorized materials 
required to perform the AllplexTM 2019-nCoV Assay are not permitted.  

3. Authorized laboratories that receive the AllplexTM 2019-nCoV Assay 
must notify the relevant public health authorities of their intent to run 
the test prior to initiating testing.  

4. Authorized laboratories using the AllplexTM 2019-nCoV Assay must have 
a process in place for reporting test results to healthcare providers and 
relevant public health authorities, as appropriate. 

5. Authorized laboratories must collect information on the performance of 
Allplex™ 2019-nCoV Assay and report to DMD/OHT7/OPEQ/CDRH (via 
email: CDRH-EUA-Reporting@fda.hhs.gov) and Seegene Technologies 
(support@seegenetech.com) any suspected occurrence of false positive 
or false negative results and significant deviations from the established 
performance characteristics of the test of which they become aware.  

 

 

 

mailto:CDRH-EUA-Reporting@fda.hhs.gov
mailto:support@seegenetech.com
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6. All laboratory personnel using the Allplex™ 219-nCoV Assay must be 
appropriately trained in RT-PCR techniques and use appropriate 
laboratory and personal protective equipment when handling this kit, 
and use the AllplexTM 2019-nCoV Assay in accordance with the 
authorized labeling.  

7. Seegene Inc., its authorized distributor(s) and authorized laboratories 
using the AllplexTM 2019-nCoV Assay must ensure that any records 
associated with this EUA are maintained until otherwise notified by FDA. 
Such records must be made available to FDA for inspection upon 
request.  

 

1 The letter of authorization refers to, “Laboratories certified under the Clinical 
Laboratory Improvement Amendments (CLIA) of 1988, 42 U.S.C. §263a, that meet 
requirements to perform high complexity tests” as “authorized laboratories.” 
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 CHAPTER 12: Performance Evaluation 
 
Limit of Detection (LoD) - Analytical Sensitivity 
 

1. A study was conducted to evaluate the LoD of the Allplex™ 2019-nCoV 
Assay on different real time PCR instruments using  SARS-CoV-2 
reference RNA material (AccuPlex SARS-COV-2 Reference Material Kit, 
Seracare Life Sciences, Inc., Cat no. 0505-0126). All sample replicates 
were prepared by spiking the reference RNA material into negative 
clinical sputum matrix. An initial- range-finding study was performed 
and included five replicates at each of four different analyte 
concentrations (i.e., 1.2X LoD, 1X LoD, 0.1X LoD, and 0.01X LoD based 
on preliminary LoD testing using an alternate RNA material). An 
additional 20 replicates were evaluated at a concentration level where 
all targets were detected in the range finding study as well as at a 3-
fold lower concentration to establish the LoD. The final LoD for each 
target was confirmed to be the lowest concentration for which at least 
19/20 replicates were detected.  

 
2. Specimen extraction was performed using the STARMag 96 X 4 

Universal Cartridge Kit and the Microlab STARlet IVD instrument. Real-
time RT-PCR was performed using the CFX96TM, and CFX96 TouchTM 
Real-time PCR Detection Systems (Bio-Rad), and the Applied 
Biosystems™ 7500 and 7500 Fast Dx (ThermoFisher Scientific) real-
time PCR systems. The LoD of each SARS-CoV-2 target is shown in 
Table 9. 

 
Table 9. LoD of each target gene  

 
 

PCR instrument Target 
Positive 

Rate 
Limit of 

Detection Unit 

CFX96™ 

E gene 20/20 4,167 Copies/mL 
RdRP 
gene 19/20 1,250 Copies/mL 

N gene 20/20 4,167 Copies/mL 

CFX96 Touch™ 

E gene 20/20 4,167 Copies/mL 

RdRP 
gene 

20/20 4,167 Copies/mL 

N gene 20/20 4,167 Copies/mL 

Applied Biosystems™ 
7500 

E gene 20/20 4,167 Copies/mL 
RdRP 
gene 20/20 4,167 Copies/mL 

N gene 20/20 4,167 Copies/mL 

E gene 20/20 4,167 Copies/mL 
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PCR instrument Target 
Positive 

Rate 
Limit of 

Detection Unit 

Applied Biosystems™ 
7500 Fast Dx 

RdRP 
gene 20/20 4,167 Copies/mL 

N gene 20/20 4,167 Copies/mL 

 
3. The final LoD of the Allplex™ 2019-nCoV Assay on CFX96TM, and 

CFX96 TouchTM Real-time PCR Detection Systems (Bio-Rad), Applied 
Biosystems™ 7500, and Applied Biosystems™ 7500 Fast Dx 
(ThermoFisher Scientific) is confirmed as in Table 10 following the 
result interpretation criteria in Table 8.  

 

Table 10. LoD Summary of the Allplex™ 2019-nCoV Assay on different real 

time PCR instruments  

 
PCR instrument Limit of Detection Unit 

CFX96TM 4,167 Copies/mL 

CFX96 TouchTM 4,167 Copies/mL 

Applied Biosystems™ 7500  4,167 Copies/mL 

Applied Biosystems™ 7500 Fast Dx 4,167 Copies/mL 

 
4. A study was conducted to evaluate the LoD of the Allplex™ 2019-nCoV 

Assay using additional extraction methods. Samples were prepared by 
spiking the same Accuplex SARS-CoV-2 reference material (catalog no. 
0505-0126) into pooled lower (sputum) respiratory negative sample 
matrix. As the  RNA target concentration of the Seracare material is 
5,000 copies/mL, an initial- range-finding study was performed and 
included five replicates at each of four different analyte concentrations 
(i.e., 1.2X LoD, 1X LoD, 0.1X LoD, and 0.01X LoD). The tentative LoD 
was determined followed by confirmatory LoD evaluation (20 replicates 
spiked at 1X LoD) for lower (sputum) respiratory negative sample 
matrix. If 20/20 replicates were detected in the confirmatory LoD 
testing, the next lower concentration, using 3-fold dilution, was tested 
until <100% detection was observed. The confirmed LoD, defined as 
the lowest SARS-CoV-2 target concentration with ≥95% detection, is 
presented in Table 11 for each extraction method. 
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Table 11. LoD Summary of the Allplex™ 2019-nCoV Assay using different 

extraction methods 

Manufacturer Instrument Extraction Kit 
Limit of 

Detection 
(Copies/mL) 

 Seegene 
Seegene STARlet  

(65415-03) 

STARMag 96 X 4 Universal 
Cartridge Kit  4,167 

STARMag 96 X 4 Viral 
DNA/RNA 200 C Kit 

4,167 

Hamilton 
Microlab STARlet IVD  

(173000-075) 

STARMag 96 X 4 Universal 
Cartridge Kit  

4,167 

STARMag 96 X 4 Viral 
DNA/RNA 200 C Kit 

4,167 

 Seegene 
Seegene NIMBUS  

(67930-03) 

STARMag 96 X 4 Universal 
Cartridge Kit  4,167 

STARMag 96 X 4 Viral 
DNA/RNA 200 C Kit 

4,167 

Hamilton Microlab NIMBUS IVD  
(65415-02) 

STARMag 96 X 4 Universal 
Cartridge Kit  

4,167 

STARMag 96 X 4 Viral 
DNA/RNA 200 C Kit 4,167 

LG Chem 
AdvanSure E3 System  

(YETS0001EG) AdvanSure NA EX Kit 4,167 

GeneAll N/A 
(Manual) 

Ribospin vRD 
(Viral RNA/DNA Extraction Kit) 

4,167 

QIAGEN 
N/A 

(Manual) 
QIAmp DSP Viral RNA Mini Kit 4,167 

Roche 
MagNA Pure 96  

(MP96) 
DNA and Viral NA Small 

Volume Kit 4,167 

ThermoFisher  
Scientific 

KingFisher Flex  
automated extraction 

MagMAX Viral/Pathogen  
Nucleic Acid Isolation Kit 

(200uL of sample is used) 
4,167 
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5. FDA SARS-CoV-2 Reference Panel 

The evaluation of sensitivity and MERS-CoV cross-reactivity was performed 
using the reference material (T1), blinded samples and a standard protocol 
provided by the FDA. The study included a range finding study and a 
confirmatory study for LoD. Blinded sample testing was used to establish 
specificity and corroborate the LoD of the Allplex™ 2019-nCoV assay. The 
extraction method and instrument used were the Seegene STARlet with 
CFX96 Touch. The results are summarized in Table 12. 

 

Table 12: Summary of LoD Confirmation Result Using the FDA SARS-CoV-2 
Reference Panel 

Reference Materials 

Provided by FDA 

Specimen Type Product LoD Cross-

Reactivity 

SARS-CoV-2 Nasopharyngeal 

swab 

6,000 NDU/mL N/A 

MERS-CoV N/A ND 

NDU/mL = RNA NAAT detectable units/mL 

N/A: Not Applicable 

ND: Not Detected 

 

6. LOD Study with WHO International Standard for SARS-CoV-2 RNA and 
Additional Consumable/PCR Instrument Equivalency 

An LOD study was conducted to re-establish the reagent performance for 
the current assay system and consumables described in the table below 
using the First WHO International Standard for SARS-CoV-2 RNA (Cat# 
20/146), acid-heat inactivated England/02/2020 isolate of SARS-CoV-2, 
spiked in the most challenging claimed matrix, clinical sputum matrix. 

The preliminary LoD study was conducted using three-fold serial dilution 
panels made with inactivated SARS-CoV-2 virus in sputum. Triplicate of 
each panel member were extracted using Seegene STARlet and tested on 
the CFX96 Touch™. The preliminary LoD study results are presented in 
the table below: 
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Sample 
Matrix 

Sample 
Concentration 

(IU/ml) 
Replicate 

Ct Results SARS-CoV-2 
Final 

Interpretation 

Result 
percentile % 

(No. of positive 
/ No. of 

replicate) 
E 

gene 
RdRP 
gene 

N 
gene Exo IC 

Sputum 

48600 

1 28.41 30.48 32.87 26.85 Detected 
100% 
(3/3) 2 27.81 30.10 32.15 26.23 Detected 

3 28.55 30.71 32.47 27.02 Detected 

16200 

1 29.30 31.72 33.83 26.16 Detected 
100% 
(3/3) 2 29.34 31.50 33.87 26.40 Detected 

3 29.51 32.41 34.76 27.21 Detected 

5400 

1 30.98 34.05 35.32 26.45 Detected 
100% 
(3/3) 2 31.02 33.97 35.74 26.27 Detected 

3 32.44 35.92 36.49 26.99 Detected 

1800 

1 32.48 34.43 38.68 26.13 Detected 
100% 
(3/3) 2 35.14 34.57 37.61 26.07 Detected 

3 35.58 N/A 39.69 26.96 Detected 

600 

1 N/A N/A N/A 26.25 Not Detected 
66% 
(2/3) 2 N/A N/A 38.52 26.54 Detected 

3 N/A 37.15 N/A 27.50 Detected 

200 

1 N/A N/A N/A 26.50 Not Detected 
66% 
(2/3) 2 N/A 35.92 N/A 26.18 Detected 

3 N/A N/A 39.64 26.50 Detected 

- 

Positive 
Control 

1 19.99 19.48 19.55 18.34 Valid 

- 2 19.91 19.39 19.42 18.30 Valid 

3 19.92 19.33 19.32 18.29 Valid 
Negative 
Control 1 N/A N/A N/A N/A Valid - 

 

The LoD was confirmed by testing twenty (20) replicates of the lowest 
three-fold dilution that produced 100% (3/3) positive results for all 3 
genes in the preliminary LoD study. If all twenty (20) replicate results 
were positive in the confirmatory LoD testing, the next lower 
concentration, using a two-fold dilution, was tested until <100% detection 

was observed. The lowest concentration with ≥95% positive result was 

reported as the confirmed LoD. The confirmed LoD was also tested with 
other instruments and consumables. The worst LoD across all instruments 
and consumables was 1350 IU/ml. The confirmatory LoD study results are 
presented in the table below: 
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Instrument Consumables Sample Concentration 
(IU/mL) 

Result Percentile %  
(No. of positive / No. of replicates 

CFX96 Touch™ 
Real-Time PCR 

Detection System  
(Bio-Rad) 

Hard-Shell® PCR plates 96-
well WHT/WHT  

(Bio-Rad) 
+ 

Permanent Clear Heat Seal 
(Bio-Rad) 

5400 100% (20/20) 

2700 100% (20/20) 

1350 100% (20/20) 

675 75% (15/20)[1] 

Hard-Shell® PCR plates 96-
well WHT/WHT  

(Bio-Rad) 
+ 

Optical Flat 8-Cap Strips  
(Bio-Rad) 

5400 100% (20/20) 

2700 100% (20/20) 

1350 100% (20/20) 

675 70% (14/20)[1] 

0.1ml 96-well PCR Plate Half 
Skirt  

(YongYue) 
+ 

Sealing Film  
(YongYue) 

5400 95% (19/20)[1] 

2700 100% (20/20) 

1350 100% (20/20) 

675 95% (19/20) 

338 55% (11/20)[1] 

CFX96™ Dx 
Real-Time PCR 

Detection System 
(Bio-Rad) 

Hard-Shell® PCR plates 96-
well WHT/WHT  

(Bio-Rad) 
+ 

Permanent Clear Heat Seal 
(Bio-Rad) 

5400 100% (20/20) 

2700 100% (20/20) 

1350 100% (20/20) 

675 70% (14/20)1 

CFX Opus 96 Dx 
Real-Time PCR 

Detection System  
(Bio-Rad) 

Hard-Shell® PCR plates 96-
well WHT/WHT  

(Bio-Rad) 
+ 

Permanent Clear Heat Seal 
(Bio-Rad) 

5400 100% (20/20) 

2700 100% (20/20) 

1350 100% (20/20) 

675 100% (20/20) 

338 85% (17/20)1 
1] Presumptive positive tests were not repeated and were considered as negative for the analysis. 

The following table includes LoD result details, including mean Ct values for each 
assay target when the Allplex 2019-nCoV Assay is run on the CFX96TM Touch 
system using the Hard-Shell PCR plates 96-well WHT/WHT (Bio-Rad) with 
Permanent Clear Heat Seal (Bio-Rad); 
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Concentration 
(copies/mL) 

E gene 
Detection Rate 
(Mean Ct) 

RdRp Gene 
Detection Rate 
(Mean Ct) 

N gene 
Detection Rate 
(Mean Ct) 

IC Detection 
Rate 
(Mean Ct) 

Detection Rate for 
SARS-CoV-2  

10,800 20/20 (29.6) 20/20 (31.3) 20/20 (33.6) 20/20 (25.9) 100% (20/20) 
5,400 20/20 (30.4) 20/20 (32.2)  20/20 (34.4) 20/20 (25.7) 100% (20/20) 
2,700 20/20 (31.7) 20/20 (33.3) 20/20 (35.5) 20/20 (25.8) 100% (20/20) 
1350 18/20 (33.1) 17/20 (34.4) 20/20 (36.7) 20/20 (26.0) 100% (20/20) 
675 5/20 (35.7) 7/20 (35.5) 13/20 (38.8) 20/20 (27.9) 75% (15/20)* 
338 2/20 (35.9) 10/20 (35.7) 11/20 (39.4)  20/20 (27.9) 75% (15/20)** 

*One presumptive positive, four negatives 
**Five negatives 

 

The following table includes LoD result details, including mean Ct values for each 
assay target when the Allplex 2019-nCoV Assay is run on the CFX96TM Touch 
system using the Hard-Shell PCR plates 96-well WHT/WHT (Bio-Rad) with Optical 
Flat 8-Cap Strips (Bio-Rad); 

Concentration 
(copies/mL) 

E gene 
Detection Rate 
(Mean Ct) 

RdRp Gene 
Detection Rate 
(Mean Ct) 

N gene 
Detection Rate 
(Mean Ct) 

IC Detection 
Rate 
(Mean Ct) 

Detection Rate for 
SARS-CoV-2  

10,800 20/20 (29.8) 20/20 (31.8) 20/20 (33.8) 20/20 (26.4) 100% (20/20) 
5,400 20/20 (30.6) 20/20 (32.8) 20/20 (34.7) 20/20 (26.3) 95% (19/20) 
2,700 20/20 (31.7) 20/20 (33.6) 20/20 (35.8) 20/20 (26.3) 100% (20/20) 
1350 20/20 (33.2) 19/20 (34.5) 20/20 (37.3) 20/20 (26.7) 100% (20/20) 
675 11/20 (35.8) 9/20 (35.8) 11/20 (38.9) 20/20 (28.6) 70% (14/20)* 
338 3/20 (36.5) 5/20 (36.1) 7/20 (39.3) 20/20 (28.6) 55% (11/20)** 

*Three presumptive positives, three negatives 
**Two presumptive positives, seven negatives 

 

The following table includes LoD result details, including mean Ct values for each 
assay target when the Allplex 2019-nCoV Assay is run on the CFX96TM Touch 
system using the the 0.1 ml 96-well PCR plate Half Skirt  (YongYue)+ Sealing film 
(YongYue): 

Concentration 
(copies/mL) 

E gene 
Detection Rate 
(Mean Ct) 

RdRp Gene 
Detection Rate 
(Mean Ct) 

N gene 
Detection Rate 
(Mean Ct) 

IC Detection 
Rate 
(Mean Ct) 

Detection Rate for 
SARS-CoV-2  

10,800 19/20 (30.7) 19/20 (33.2) 20/20 (34.9) 20/20 (26.2) 100% (20/20) 
5,400 20/20 (31.3) 18/20 (33.9) 19/20 (35.6) 20/20 (26.7) 95% (19/20) 
2,700 20/20 (31.0) 20/20 (33.6) 20/20 (35.3) 20/20 (26.3) 100% (20/20) 
1,350 20/20 (31.3) 20/20 (33.7) 20/20 (35.7) 20/20 (26.2) 100% (20/20) 
675 11/20 (35.4) 8/20 (35.2) 18/20 (38.5) 20/20 (27.1) 95% (19/20)* 
338 4/20 (35.8) 3/20 (35.7) 9/20 (38.7) 20/20 (27.3) 55% (11/20)** 

*One negative 
** One presumptive positive, eight negatives 

 

The following table includes LoD result details, including mean Ct values for each 
assay target when the Allplex 2019-nCoV Assay is run on the CFX96TM Dx system 
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using the Hard-Shell PCR plates 96-well WHT/WHT (Bio-Rad) with Permanent Clear 
Heat Seal (Bio-Rad); 

 

Concentration 
(copies/mL) 

E gene 
Detection Rate 
(Mean Ct) 

RdRp Gene 
Detection Rate 
(Mean Ct) 

N gene 
Detection Rate 
(Mean Ct) 

IC Detection 
Rate 
(Mean Ct) 

Detection Rate for 
SARS-CoV-2  

10,800 20/20 (29.8) 20/20 (32.1) 20/20 (33.8) 20/20 (26.3) 100% (20/20) 
5,400 20/20 (30.6) 20/20 (33.1) 20/20 (34.8) 20/20 (26.3) 100% (20/20) 
2,700 20/20 (32.1) 20/20 (33.9) 20/20 (36.3) 20/20 (26.5) 100% (20/20) 
1,350 19/20 (33.7) 19/20 (34.9) 20/20 (37.5) 20/20 (26.5) 100% (20/20) 
675 6/20 (36.6) 6/20 (36.5) 12/20 (38.8) 20/20 (28.0) 70% (14/20)* 
338 3/20 (36.6) 4/20 (36.7) 4/20 (38.9) 20/20 (28.1) 35% (7/20)** 

* Two presumptive positives, four negatives 
**Three presumptive positives, ten negatives 

 

The following table includes LoD result details, including mean Ct values for each 
assay target when the Allplex 2019-nCoV Assay is run on the CFX Opus 96 Dx 
system using the Hard-Shell PCR plates 96-well WHT/WHT (Bio-Rad) with 
Permanent Clear Heat Seal (Bio-Rad); 

Concentration 
(copies/mL) 

E gene 
Detection Rate 
(Mean Ct) 

RdRp Gene 
Detection Rate 
(Mean Ct) 

N gene 
Detection Rate 
(Mean Ct) 

IC Detection 
Rate 
(Mean Ct) 

Detection Rate for 
SARS-CoV-2  

10,800 20/20 (30.6) 20/20 (31.9) 20/20 (33.4) 20/20 (26.2) 100% (20/20) 
5,400 20/20 (31.1) 20/20 (32.6) 20/20 (33.8) 20/20 (26.0) 100% (20/20) 
2,700 20/20 (32.5) 20/20 (33.4) 20/20 (34.7) 20/20 (26.1) 100% (20/20) 
1,350 18/20 (34.0) 19/20 (34.3) 20/20 (35.7) 20/20 (26.3) 100% (20/20) 
675 11/20 (33.5) 16/20 (34.9) 20/20 (36.7) 20/20 (26.3) 100% (20/20) 
338 12/20 (34.8) 10/20 (35.2) 15/20 (37.3) 20/20 (26.6) 85% (17/20)* 

* One presumptive positive, two negatives 
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Inclusivity (Analytical Sensitivity) 
 

Inclusivity was evaluated using in silico analysis to analyze the sequences 
of the RdRP, N, and E gene primer/probe sets for homology with 16,667 
full length sequences available in the GISAID database (http://gisaid.org) 
and 3490 full length sequences available in the NCBI database 
(https://ncbi.nhm.nih.gov/datasets/coronavirus/genomes/) as of May 13, 
2020. The in-silico analysis generated 9 cases where there were less than 
100% homology in the primer/probe region. All cases had mismatches in 
only one of the target regions and is predicted to not impact the detection 
of SARS-CoV-2. All 9 cases were wet-tested using in vitro transcribed RNA 
containing the specific variant/mismatch sequences and demonstrated 
that all 9 cases were detected at 3x LoD. 

During the omicron surge, an additional in-silico analysis was performed 
based on the GISAID database added in the US for the time period of 
February 23, 2022 through March 25, 2022. The sequences of the RdRP, 
N, and E gene primer/probe sets were analyzed for homology with the 
33,388 SARS-CoV-2 sequences. The result of the in-silico analysis found 
two sequences with less than 100% homology with greater than 5% 
prevalence in the time-period (one 1-mer mismatch in the N gene forward 
primer, one 1-mer mismatch in the E gene forward primer). Both 
sequences were wet tested using in vitro transcribed RNA containing the 
specific variant/mismatch sequences and demonstrated that both cases 
were detected at 3x LoD. In all cases where mismatches were observed in 
the in-silico analysis, the mismatches were in only one of the target 
regions and is predicted to not impact the detection of SARS-CoV-2. 

In silico analysis was also performed on three Omicron sub-lineage 
sequences (BA.4, BA.5, and BA.275) in the GISAID database as of August 
25, 2022. The sequences of the RdRP, N, and E gene primer/probe sets 
were analyzed for homology with the 73,770 SARS-CoV-2 sequences 
(BA.2.75, n = 3,680; BA.4, n=41,063; BA.5, n=29,027). In all cases where 
mismatches were observed in the in-silico analysis, the mismatches were 
in only one of the target regions, or the mismatch was demonstrated to be 
detected through wet-testing. Therefore, all sequences analyzed are 
predicted to not impact the detection of SARS-CoV-2. 

 

 

 

 

http://gisaid.org/
https://ncbi.nhm.nih.gov/datasets/coronavirus/genomes/
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Cross-reactivity (Analytical Specificity) 
 

Evaluation of Cross-reactivity with high priority pathogens 
 

In silico analysis was performed to evaluate the potential for cross-
reactivity of the Allplex™2019-nCoV Assay targets with pathogens listed in 
Table 13 that may be encountered in clinical respiratory specimens. In 
addition, the pathogens listed in Table 15, were also wet tested. 

 

Table 13. List of pathogens analyzed in silico  

Other high priority pathogens 
from the same genetic family 

High priority pathogens likely in 
the circulating area 

Human coronavirus 229E Adenovirus (e.g. C1 Ad. 71) 

Human coronavirus OC43 
Human Metapneumovirus 
(hMPV) 

Human coronavirus HKU1 Parainfluenza virus 1-4 

Human coronavirus NL63 Influenza A & B 

SARS-coronavirus  Enterovirus (e.g. EV68) 

MERS-coronavirus Respiratory syncytial virus  

 

Rhinovirus 

Chlamydia pneumoniae 
Haemophilus influenzae 
Legionella pneumophila 
Mycobacterium tuberculosis 
Streptococcus pneumoniae 
Streptococcus pyogenes 
Bordetella pertussis 
Mycoplasma pneumoniae 
Pneumocystis jirovecii (PJP) 
Candida albicans 
Pseudomonas aeruginosa 
Staphylococcus epidermis 
Streptococcus salivarius 
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In silico analysis test results 

 

Cross-reactivity of the Allplex™ 2019-nCoV Assay was evaluated by in silico 
analysis and cross-reactivity was defined as greater than 80% homology 
between ‘oligo set’ and any sequence present in the targeted 
microorganism as table above. Cross-reaction is likely to occur when first, 
the amplicon size is below 500 bp, and second, when the homology of the 
binding site between the oligo set (forward primer, reverse primer, and 
probe) and the microorganism is greater or equal to 80% (Table 14. In 
silico analysis results of targeted pathogens). 

 

Table 14. In silico analysis results of targeted pathogens 

Pathogen RdRP gene E gene N gene Complex 

Human coronavirus 
229E Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Human coronavirus 
OC43 Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Human coronavirus 
HKU1 Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Human coronavirus 
NL63 

Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

SARS-coronavirus  Amp. Mis. # 100% 
Match* 

Amp. Mis. # Amp. Mis. # 

MERS-coronavirus Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Adenovirus Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Human 
Metapneumovirus Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Parainfluenza virus 1 Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Parainfluenza virus 2 Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Parainfluenza virus 3 Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Parainfluenza virus 4 Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Influenza A virus Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Influenza B virus Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Enterovirus Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Respiratory syncytial 
virus  

Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Rhinovirus Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Chlamydia 
pneumoniae Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 
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Pathogen RdRP gene E gene N gene Complex 

Hemophilus influenzae Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Legionella 
pneumophila Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Mycobacterium 
tuberculosis Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Streptococcus 
pneumoniae Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Streptococcus 
pyogenes Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Bordetella pertussis Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Mycoplasma 
pneumoniae Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Pneumocystis 
gynoecia (PJP) Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Candida albicans Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Pseudomonas 
aeruginosa Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Staphylococcus 
epidermis Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

Streptococcus 
salivarius Amp. Mis. # Amp. Mis. # Amp. Mis. # Amp. Mis. # 

 
NOTE:    
(*) E gene covers 100% of SARS-coronavirus (taxonomy ID: 694009) 
(#) Amp. Mis: Amplicon mismatch. Amplicon is not predicted to be 

formed. The combination of assay oligos with each microorganism did 
not achieve above 80% homology. 

 

As a result of the analysis, there were no microorganisms with potential 
non-specific or cross-reactive sequences except for E gene target 
sequences that showed a 100% match with SARS-coronavirus. E gene is a 
target gene for Sarbecovirus, so the results of the in silico analysis are 
expected (see Table 8 for result interpretation).  
 
The Allplex™ 2019-nCoV Assay was further evaluated for potential cross-
reactivity by wet-testing a total of 60 pathogens as well as pooled human 
nasal wash (Table 15). The bacterial species were tested at ≥ 1 x 106 

CFU/mL, and viral species at ≥ 1 x 105 PFU/mL or 1 x 106 genome 
copies/rxn.  
 
Testing with the Allplex™ 2019-nCoV Assay was performed in triplicate for 
each organism under the same conditions. None of the 60 pathogens or the 
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pooled human nasal wash generated detectable signals with SARS-CoV-2 
targets of the Allplex™ 2019-nCoV Assay. 
 
Table 15. List of pathogens evaluated by wet testing 
 

No. Usage Pathogen Source Isolate No. 

1 Exclusivity human coronavirus HKU1 Korean isolate 

2 Exclusivity human coronavirus OC43 ATCC VR-1558 

3 Exclusivity human coronavirus NL63 Korean isolate 

4 Exclusivity human coronavirus 229E ATCC VR-740 

5 Exclusivity 
human Severe Acute Respiratory 
Syndrome, SARS Korean isolate 

6 Exclusivity 
human Middle East Respiratory 
Syndrome Coronavirus: MERS-CoV Korean isolate 

7 Exclusivity influenza A virus (H1N1) ATCC VR-95 

8 Exclusivity Influenza A virus (H3N2) ATCC VR-547 

9 Exclusivity influenza B virus ATCC VR-523 

10 Exclusivity Human Rhinovirus 1 KBPV VR-81 

11 Exclusivity Rhinovirus 21 KBPV VR-40 

12 Exclusivity Human rhinovirus type 90 ATCC VR-1291 

13 Exclusivity Human rhinovirus type 16 ATCC VR-283 

14 Exclusivity Human rhinovirus type 42 ATCC VR-338 

15 Exclusivity Human rhinovirus type 8 ATCC VR-488 

16 Exclusivity Human rhinovirus type 14 ATCC VR-284 

17 Exclusivity Human enterovirus type 68 ATCC VR-1826 

18 Exclusivity Human enterovirus type 70 ATCC VR-836 

19 Exclusivity Human enterovirus type 71 ATCC VR-784 

20 Exclusivity human respiratory syncytial virus A ATCC VR-26 

21 Exclusivity human respiratory syncytial virus B ATCC VR-955 

22 Exclusivity Parainfluenza 1 virus ATCC VR-1380 

23 Exclusivity Human parainfluenza virus 2 ATCC VR-92 

24 Exclusivity Human parainfluenza virus 3 ATCC VR-93 

25 Exclusivity human parainfluenza 4 virus 4a ATCC VR-1378 

26 Exclusivity Human parainfluenza virus 4b ATCC VR-1377 

27 Exclusivity Human Metapneumovirus (MPV) KBPV VR-87 

28 Exclusivity Human adenovirus 1 ATCC VR-1 

29 Exclusivity Human adenovirus 11 KBPV VR-63 

30 Exclusivity Human adenovirus 18 ATCC VR-1095 

31 Exclusivity Human adenovirus 23 ATCC VR-1101 

32 Exclusivity Human adenovirus 3 ATCC VR-3 

33 Exclusivity Human adenovirus 4 ATCC VR-1572 
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No. Usage Pathogen Source Isolate No. 

34 Exclusivity Human adenovirus 8 ATCC VR-1368 

35 Exclusivity Human adenovirus type 31 ATCC VR-1109 

36 Exclusivity Human adenovirus type 40 ATCC VR-931 

37 Exclusivity Human adenovirus type 5 KBPV VR-61 

38 Exclusivity Human adenovirus type 35 ATCC VR-718  

39 Exclusivity Legionella pneumophila Serotype 2 ATCC 33154 

40 Exclusivity 
Legionella pneumophila subsp. 
fraseri Serotype 4 ATCC 33156 

41 Exclusivity Legionella pneumophila Serotype 7 ATCC 33823 

42 Exclusivity Legionella pneumophila Serotype 10 ATCC 43283 

43 Exclusivity Legionella pneumophila Serotype 11 ATCC 43130 

44 Exclusivity Legionella pneumophila Serotype 12 ATCC 43290 

45 Exclusivity Legionella pneumophila Serotype 13 ATCC 43736 

46 Exclusivity Legionella pneumophila Serotype 14 ATCC 43703 

47 Exclusivity 
Legionella pneumophila subsp. 
fraseri Serotype 15 ATCC 35251 

48 Exclusivity Mycoplasma pneumoniae ATCC 15293 

49 Exclusivity Mycoplasma pneumoniae M129-B7 ATCC 29342 

50 Exclusivity Chlamydophila pneumoniae ATCC 53592 

51 Exclusivity Bordetella pertussis ATCC BAA-589 

52 Exclusivity 
Pseudomonas aeruginosa (Z139; 
VIM-1) Zeptometrix 801908 

53 Exclusivity Mycobacterium tuberculosis ATCC 25177 

54 Exclusivity Haemophilus influenzae ATCC 51907 

55 Exclusivity Streptococcus pneumoniae KCCM 40410 

56 Exclusivity Streptococcus pyogenes ATCC 19615 

57 Exclusivity Staphylococcus epidermidis KCCM 40416 

58 Exclusivity Candida albicans KCCM 11282 

59 Exclusivity 
Pneumocystis pneumonia jirovecii 
(PJP) Korean isolate 

60 Exclusivity Staphylococcus salivarius Korean isolate 

61 Exclusivity Pooled human nasal wash Clinical sample 
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Clinical Evaluation 
 

In the clinical evaluation study, selected left-over archived samples from 
symptomatic patients suspected of COVID-19 infection were used. 
Specimens were previously subjected for SARS-CoV-2 testing and then 
stored at a clinical laboratory in South Korea prior to being included in 
this study. A total of 300 samples (150 upper respiratory samples, 150 
lower respiratory samples); 100 positive samples (50 upper respiratory 
samples (NP/OP swabs in UTM), 50 sputum samples) and 200 negative 
samples (100 upper respiratory samples (NP/OP swabs in UTM), 100 
sputum samples) were tested. The purpose of this clinical study was to 
assess the clinical performance of Seegene’s AllplexTM 2019-nCoV Assay. 

For this study, extraction was performed using the STARMag 96 X 4 
Universal Cartridge Kit and the Microlab STARlet IVD instrument. Real-
time RT-PCR was performed using the CFX96 Real-time PCR Detection 
System (Bio-Rad). 

 

All specimens were evaluated with the Allplex™ 2019-nCoV Assay and a 
validated real-time PCR comparator assay. The comparator assay primers 
and probes were identical to the CDC 2019-Novel Coronavirus (2019-
nCoV) Real-Time RT-PCR Diagnostic Panel but used alternate extraction 
and PCR instrumentation.  The LoD of the comparator assay was shown 
to be equivalent to the CDC assay and therefore adequate for evaluation 
of clinical performance for the Allplex™ 2019-nCoV Assay.  

The results from testing upper respiratory specimens including 
nasopharyngeal + oropharyngeal swabs shown in Table 16 generated a 
Positive Percent Agreement (PPA): 100.00% (49/49) [95% CI: 92.75% - 
100.00%], and a  Negative Percent Agreement (NPA): 93.07% (94/101) 
[95% CI: 85.76% - 96.93%]. 

The results from testing lower respiratory specimens (sputum) shown in 
Table 17, generated Positive Percent Agreement (PPA): 100.00% (49/49) 
[95% CI: 92.75% - 100.00%], and a Negative Percent Agreement (NPA): 
96.84% (92/95) [95% CI: 90.39% - 99.18%] 
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Table 16. Upper respiratory samples  
(nasopharyngeal + oropharyngeal swab) n=150 

NOTE: (1) Sequencing result was SARS-CoV-2 positive (Comparator assay: 
N1 positive / N2 negative) 

(2) Sequencing results were SARS-CoV-2 positive for 5 cases, and 
SARS-CoV-2 negative for 1 remaining case. 

 
A. Positive Percent Agreement (PPA): 100.00% (49/49)  

[95% CI: 92.75% - 100.00%] 
B. Negative Percent Agreement (NPA): 93.07% (94/101)  

[95% CI: 85.76% - 96.93%] 
 

Table 17. Lower Respiratory samples (Sputum) n=150 

Final results 

Comparator assay 

2019-nCoV 
Detected 

Inconclusive 
2019-nCoV 

Not 
Detected 

Total 

Allplex™ 
2019-nCoV 

Assay 

SARS-CoV-2 
Positive 49 11) 22) 52 

Presumptive 
Positive for 
SARS-CoV-2 

0 0 0 0 

Negative 0 0 92 92 

Total 49 1 94 144 

NOTE: (1) Sequencing result was SARS-CoV-2 positive. (Comparator 
assay: N1 negative / N2 positive)  

(2) Sequencing results were all SARS-CoV-2 positive for 2 cases. 
 
A. Positive Percent Agreement (PPA): 100.00% (49/49)  

[95% CI: 92.75% - 100.00%] 
B. Negative Percent Agreement (NPA): 96.84% (92/95)  

[95% CI: 90.39% - 99.18%] 

 

Final results 

Comparator assay  

2019-nCoV 
Detected 

Inconclusive 
2019-nCoV 

Not 
Detected 

Total 

Allplex™ 
2019-nCoV 

Assay 

SARS-CoV-2 
Positive 49 11) 62) 56 

Presumptive 
Positive for SARS-

CoV-2 
0 0 0 0 

Negative 0 0 94 94 

Total 49 1 100 150 
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 CHAPTER 13: Key to Symbols 
 

Symbol Explanation 

 

In vitro diagnostic medical device 

 

Batch code 

 

Catalog number 

 

Use-by date 

 

Upper limit of temperature 

 

Oligonucleotide mix for amplification and detection 

 

Enzyme Mix 

 

Buffer 

 

RNase-free Water 

 

Positive Control (PC) 

 

Internal Control (IC) 

 

Consult instructions for use 

 

Manufacturer 

 

Date of manufacture 

 

Caution 

  Contains sufficient for <n> tests 

 

Prescription Use only 

 

Emergency Use Authorization 

 
Unique Device Identifier 

 
Reaction barcode for automated extraction system 

 



 
 

Page 87 / 88 

AllplexTM 2019-nCoV Assay 

 CHAPTER 14: Ordering Information 
 

The product will be distributed by Seegene Inc., located at Taewon Bldg., 
91. Ogeum-ro, Songpa-gu, Seoul, Republic of Korea, 05548, and   
Seegene Technologies located at 325 N Wiget Ln #140, Walnut Creek, CA 
94598 U.S.A. 

 

 CHAPTER 15: EUO Label For RUO Instruments 
 

For the Applied BioSystems 7500, Bio-Rad CFX96 Real-Time PCR 
Detection System, and CFX96 Touch Real-Time PCR Detection System, 
affix the Emergency Use Only (EUO) label on each instrument and retain 
this labeling throughout the Emergency Use Authorization (EUA) use of 
the claimed Real-Time PCR instruments. 

1. Print the following EUO label: 

 

Visible affix the EUO instrument verification label on your instrument. If the 
instrument includes labeling indicating “For Research Use Only”, cover with 
the EUO instrument label. 

 

 

 

 

 

 

Emergency Use Only 
 

This instrument is authorized for use with 
Seegene, Inc. Allplex™ 2019-nCoV Assay that 
have received Emergency Use Authorization. 
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Seegene Inc., Taewon Bldg., 91. Ogeum-ro, Songpa-gu, Seoul, 
Republic of Korea, 05548 

 

Customer Support & Technical Support: support@seegenetech.com 

For more contact information visit www.seegene.com 

Seegene and Allplex are trademarks and/or registered trademarks of 
Seegene Inc. in the United States and/or other countries. 

All other trademarks that may appear in this package insert are the 
property of Seegene Inc. 

This product is covered by one or more U.S. patents.  

 

©2020 Seegene Inc. All rights reserved. 

mailto:support@seegenetech.com
http://www.seegene.com/


  Allplex™ 2019-nCoV Assay 

 

 

For use under Emergency Use Authorization (EUA) only 

 

Allplex™ 2019-nCoV Assay 

Product Information Card (PIC) 

 

• This product information card does not contain the full instructions. 

• Please contact support@seegenetech.com if you require a printed copy 
free of charge. 

• Healthcare Provider (HCP) and Patient Fact Sheets and Instructions for 
Use can be found at the following link: 
https://www.fda.gov/medical-devices/coronavirus-disease-2019-covid-
19-emergency-use-authorizations-medical-devices/in-vitro-diagnostics-
euas-molecular-diagnostic-tests-sars-cov-2 

• This product has not been FDA cleared or approved, but has been 
authorized for emergency use by FDA under an EUA for use by authorized 
laboratories. 

• This product has been authorized only for the detection of nucleic acid 
from SARS-CoV-2, not for any other viruses or pathogens. 

• The emergency use of this product is only authorized for the duration of 
the declaration that circumstances exist justifying the authorization of 
emergency use of in vitro diagnostics for detection and/or diagnosis of 
COVID-19 under Section 564(b)(1) of the Federal Food, Drug and 
Cosmetic Act, 21 U.S.C. § 360bbb-3 (b)(1), unless the declaration is 
terminated or authorization is revoked sooner. 

 

 

 

 

 

 Rev.0, December 13 2022 

mailto:support@seegenetech.com
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